Handy Backup
User Manual

Version 6.1.0

Published on 1st October, 2008.
# Contents

## General Information
- Product Overview ................................................................. 5
- Copyright Notice ................................................................... 7
- End User License Agreement .................................................. 8
- Technical Support Contacts .................................................. 11

## Installation and Getting Started
- Handy Backup Installation .................................................. 13
- Updating from Earlier Versions ............................................ 14
- System Requirements ........................................................... 14
- First Start ............................................................................. 16
- Registration ......................................................................... 16
- Uninstalling ......................................................................... 17

## Handy Backup Basics
- Operation Types ................................................................... 18
  - Backup ................................................................................ 18
  - Restore .............................................................................. 18
  - Synchronization ................................................................ 18
- Tasks .................................................................................... 19
  - Creating New Task .......................................................... 19
  - Modifying Task ................................................................ 19
  - Duplicating Task .............................................................. 20
  - Running Task .................................................................... 20
  - Stopping Task ................................................................... 21
  - Deleting Task ................................................................... 21

## Managing Data with Handy Backup
- Backing Up Data .................................................................. 23
  - Standard Mode .................................................................. 23
    - Step 1: Choose Task Type ................................................ 24
    - Step 2: What to Backup ................................................... 24
    - Step 3: Backup Type ........................................................ 27
    - Step 4: Select Destination ............................................... 27
      - Backup to Local Disk/External HDD/USB Disk/Flash/Lan  28
      - Backup to FTP ................................................................ 29
      - Backup to SFTP ............................................................ 31
      - Backup to CD-R/CD-RW .............................................. 31
      - Backup to Blu-Ray/HD-DVD/DVD .................................. 32
      - Handy Backup Online ............................................... 33
    - Step 5: How to Backup .................................................... 34
    - Step 6: When to Backup ................................................... 35
    - Step 7: How Often to Backup .......................................... 35
    - Step 8: What Time to Backup ......................................... 36
    - Step 9: Name the Backup Task ....................................... 38
  - Expert Mode ....................................................................... 39
    - Step 1: Choose Task Type ................................................ 39
    - Step 2: Specify Backup Set .............................................. 40
    - Step 3: Select Destination ............................................... 41
Handy Backup User Manual

User Interface 66

Main Menu ................................................................................................................................................. 66
Main Menu -> File ....................................................................................................................................... 66
Task Properties ........................................................................................................................................... 67
    Setting Pre- and Post- Actions .............................................................................................................. 68
    Enabling Shutdown after Task Execution ......................................................................................... 69
    Enabling E-mail Notification ............................................................................................................. 69
Settings .......................................................................................................................................................... 70
    General settings ................................................................................................................................. 71
    Log settings ......................................................................................................................................... 72
    File View settings ............................................................................................................................... 72
    Transfer settings ................................................................................................................................. 73
    Prompts ................................................................................................................................................. 73
    E-mail Notification .............................................................................................................................. 74
    Updates .................................................................................................................................................. 75
    Plug-ins .................................................................................................................................................. 76
Configuration ............................................................................................................................................... 77
Main Menu -> View ................................................................................................................................... 78
Main Menu -> Actions ............................................................................................................................... 79
Main Menu -> Service ............................................................................................................................... 79
Main Menu -> Language ............................................................................................................................ 80
How to Create Different Language Versions of Handy Backup .............................................................. 80
Main Menu -> Help ................................................................................................................................... 82
Toolbar ....................................................................................................................................................... 82
Task View Window .................................................................................................................................... 83
File View Window ..................................................................................................................................... 84
Log Window ............................................................................................................................................... 85
Hot Keys .................................................................................................................................................... 86
Handy Backup Agent .................................................................................................................................. 88
Agent Menu ............................................................................................................................................... 88
Command Line .......................................................................................................................................... 89

Backup Extras 90

Updates ............................................................................................................................................................ 91
Image Backup ............................................................................................................................................. 92
    Before You Back Up ............................................................................................................................ 93
    Where to Back Up ............................................................................................................................... 94
Hard Drive Restoration .............................................................................................................................. 94
Database Backup ......................................................................................................................................... 94
    File Data Source .................................................................................................................................. 96
Handy Backup is the best-in-class, award winning data protection solution for individuals as well as corporate users, providing easy, comprehensive and cost effective backup and recovery of critical data.

**Ease of use**

An intuitive, user-friendly interface simplifies data protection and recovery procedures for users of all levels. In addition, Handy Backup contains an excellent task-oriented help system. Help files offer clear, step-by-step instructions and troubleshooting tips. The language is easy to understand and the help information is well organized so the answers can be found fast.

**Universality**

Handy Backup is designed to backup all types of data, which are searched automatically, never asking you to point out the data location. The user has to do as little as to specify the data to be backed up and the program will do the rest.

The application works with most types of storage devices including external or internal hard drives, removable media, CD/DVD disks, as well as local networks and remote servers, which allows users to retrieve their data anytime anywhere.

Backup tasks can be scheduled and run automatically on both one-off and regular basis. To fit users' needs the schedule can be easily modified. The program keeps users informed via e-mail as to how the backup process is going and if it is complete yet.

**Supplementary data handling tools**

The use of Zip compression allows to considerably reduce both storage space and online time while running a backup to a remote server. The user can modify both the type of compression parameters and the level of compression.

To protect data from unauthorized access, strong 128-bit blowfish encryption algorithm is used. This is one of the most advanced Internet backup encryption methods. Files, encrypted with Handy Backup, will never be decrypted without a unique password and Handy Backup.

To keep files and folders, included into a backup copy, identical to their sources, Handy Backup provides a synchronization feature. Synchronization can be performed between all known storage devices, remote servers, within LANs etc.

**Online backup**

To solve the problem of personal online storage space, users can take advantage of Handy Backup Online Service. This service allows archiving files of any format to the Internet servers, located in a secured shelter fully protected against natural and technological disasters, as well as against any unforeseen events.
**Enriched functionality**

Additional upgrades considerably enlarge the functionality of the program. The Backup to DVD feature allows saving large amounts of data to a single disk; Secure FTP (SFTP) support ensures full protection of backed up data while transferring them; Windows service mode provides the opportunity to completely automate backup operations and run them without any human intervention. All the upgrades are available to the owners of the base version on the product website: [http://www.handybackup.net](http://www.handybackup.net).

**Multilanguage support**

Starting with version 5.4 Handy Backup supports not only English but other languages. In the future the number of languages provided by default will be increased. In addition, users are encouraged to create their own language interfaces. This was made possible due to the appearance of the new language configuration system that now relies on xml-files including all texts displayed in the program. These files are easy to modify, so computer users of all levels could make particular translations of Handy Backup using Notepad or any other text editor. To learn how to translate Handy Backup, see How to create different language versions of Handy Backup.

**Always up-to-date**

Novosoft developers constantly work on improving Handy Backup software to make it an ideal tool for trouble-free backups. We always take into consideration users' recommendations to find out if any improvements and modifications are needed.

Watch the product website at [http://www.handybackup.net](http://www.handybackup.net) for updates!
Copyright Notice

Copyright© Novosoft LLC 2002-2008. All rights reserved.

All trademarks and registered trademarks used in this documentation are property of their respective owners. Outlook Express®, Outlook®, Internet Explorer®, Windows® and Microsoft® are registered trademarks of Microsoft® Corporation.

Warning: This computer program is protected by copyright law and international treaties. Unauthorized reproduction or distribution of Handy Backup, or any portion of it that is owned by Novosoft, may result in severe civil and criminal penalties, and will be prosecuted to the maximum extent possible under the law.
Handy Backup is copyrighted and licensed software, so please read carefully the Handy Backup License Agreement.

Novosoft Handy Backup End User License Agreement

THIS SOFTWARE END USER LICENSE AGREEMENT (HEREINAFTER REFERRED TO AS THE "EUL") IS A LEGAL AGREEMENT BETWEEN THE EUL END-USER (HEREINAFTER REFERRED TO AS "YOU") AND NOVOSOFT DEVELOPMENT LLC AS THE EUL LICENSOR (HEREINAFTER REFERRED TO AS THE "NOVOSOFT"). USE OF THE SOFTWARE PROVIDED WITH THIS AGREEMENT (HEREINAFTER REFERRED TO AS THE "SOFTWARE") CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. READ IT CAREFULLY BEFORE COMPLETING THE INSTALLATION PROCESS AND USING THE SOFTWARE. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL AND/OR USE THIS SOFTWARE. BY INSTALLING, COPYING, OR OTHERWISE USING THE SOFTWARE PRODUCT, YOU AGREE TO BE BOUND BY THE TERMS OF THIS EUL.

1. LICENSE GRANT

NOVOSOFT GRANTS YOU A LICENSE TO USE ONE COPY OF THIS VERSION OF THE SOFTWARE ON A SINGLE COMPUTER. "YOU" MEANS THE COMPANY, ENTITY OR INDIVIDUAL WHO DOWNLOADS THE SOFTWARE TO USE IT. "USE" MEANS STORING, LOADING, INSTALLING, EXECUTING OR DISPLAYING THE SOFTWARE. YOU MAY NOT MODIFY THE SOFTWARE OR DISABLE ANY LICENSING OR CONTROL FEATURES OF THE SOFTWARE EXCEPT AS AN INTENDED PART OF THE SOFTWARE PROGRAMMING FEATURES. THIS LICENSE IS NOT TRANSFERABLE TO ANY OTHER SYSTEM, OR TO ANOTHER ORGANIZATION OR INDIVIDUAL.

2. TRIAL AND REGISTRATION

YOU ARE GRANTED THE RIGHT TO USE THE SOFTWARE WITHOUT REGISTRATION SOLELY FOR THE PURPOSES OF EVALUATING THE PERFORMANCE OF THE SOFTWARE FOR A PERIOD OF NO MORE THAN 30 DAYS. IF AFTER THAT TIME CONTINUED USE OF THE SOFTWARE IS DESIRED THEN THE SOFTWARE MUST BE REGISTERED WITH NOVOSOFT SUBJECT TO THE TERMS AS LAID OUT IN THE REGISTRATION INFORMATION WHICH CAN BE FOUND IN THE DOCUMENTATION ACCOMPANYING THE SOFTWARE. YOU ARE EXPECTED TO USE THE SOFTWARE ON YOUR SYSTEM AND TO THOROUGHLY EVALUATE ITS USEFULNESS AND FUNCTIONALITY BEFORE REGISTRATION. THIS "TRY BEFORE YOU REGISTER" APPROACH IS THE ULTIMATE GUARANTEE THAT THE SOFTWARE WILL PERFORM TO YOUR SATISFACTION.

3. OWNERSHIP

THE SOFTWARE IS OWNED AND COPYRIGHTED BY NOVOSOFT AND OTHER PERSONS AND/OR ENTITIES DULY AUTHORIZED, IF ANY (HEREINAFTER COLLECTIVELY REFERRED TO AS THE "OWNERS"). YOUR LICENSE CONFRS NO TITLE OR OWNERSHIP IN THE SOFTWARE AND SHOULD NOT BE CONSTRUED AS A SALE OF ANY RIGHT IN THE SOFTWARE.

4. COPYRIGHT
THE SOFTWARE AND ALL RIGHTS, WITHOUT LIMITATION INCLUDING PROPRIETARY RIGHTS THEREIN, ARE OWNED BY THE OWNERS AND ARE PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER INTELLECTUAL PROPERTY LAWS AND TREATIES. THE SOFTWARE IS LICENSED, NOT SOLD. YOU ACKNOWLEDGE THAT NO TITLE TO THE INTELLECTUAL PROPERTY IN THE SOFTWARE IS TRANSFERRED TO YOU. YOU FURTHER ACKNOWLEDGE THAT TITLE AND FULL OWNERSHIP RIGHTS TO THE SOFTWARE WILL REMAIN THE EXCLUSIVE PROPERTY OF THE OWNERS AND YOU WILL NOT ACQUIRE ANY RIGHTS TO THE SOFTWARE EXCEPT AS EXPRESSLY SET FORTH IN THIS LICENSE. YOU AGREE THAT ANY COPIES OF THE SOFTWARE WILL CONTAIN THE SAME PROPRIETARY NOTICES WHICH APPEAR ON AND IN THE SOFTWARE.

5. REVERSE ENGINEERING

YOU AGREE THAT YOU WILL NOT ATTEMPT TO REVERSE COMPILe, MODIFY, TRANSLATE, OR DISASSEMBLE THE SOFTWARE IN WHOLE OR IN PART.

6. NO OTHER WARRANTIES

THE SOFTWARE PRODUCT IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND. NOVOSOFT DISCLAIMS ALL OTHER WARRANTIES WITH RESPECT TO THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY MAY LAST, OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION.

7. SEVERABILITY

IN THE EVENT OF INVALIDITY OF ANY PROVISION OF THIS LICENSE, THE PARTIES AGREE THAT SUCH INVALIDITY SHALL NOT AFFECT THE VALIDITY OF THE REMAINING PORTIONS OF THIS LICENSE.

8. NO LIABILITY FOR CONSEQUENTIAL DAMAGES

IN NO EVENT SHALL THE OWNERS OR THEIR SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF NOVOSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL NOVOSOFT' LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

9. GOVERNING LAW

THIS AGREEMENT IS GOVERNEO BY THE LAWS OF THE RUSSIAN FEDERATION. IF FOR ANY PROVISION OR PORTION THEREOF OF THE LICENSE AGREEMENT IS FOUND TO BE UNENFORCEABLE BY A COURT OF COMPETENT JURISDICTION, THAT PROVISION SHALL BE ENFORCED IN SUCH MANNER AS TO EFFECT THE INTENTION OF THE PARTIES HEREOF, AND THE REMAINDER OF THE LICENSE AGREEMENT SHALL CONTINUE IN FULL FORCE AND EFFECT.

10. GENERAL PROVISION
THIS IS THE ENTIRE AGREEMENT BETWEEN YOU AND NOVOSOFT, WHICH SUPERSEDES ANY PRIOR AGREEMENT OR UNDERSTANDING, WHETHER WRITTEN, OR ORAL, RELATING TO THE SUBJECT MATTER OF THIS LICENSE. IF ANY PART OF THIS AGREEMENT IS FOUND VOID AND UNENFORCEABLE, IT WILL NOT AFFECT THE VALIDITY OF THE BALANCE OF THE AGREEMENT, WHICH SHALL REMAIN VALID AND ENFORCEABLE ACCORDING TO ITS TERMS. THIS AGREEMENT SHALL AUTOMATICALLY TERMINATE UPON FAILURE BY YOU TO COMPLY WITH ITS TERMS. NOVOSOFT, ON ITS SOLE DISCRETION, MAY MODIFY THIS AGREEMENT IN WRITING AT ANY TIME.
Users of Handy Backup are entitled to free technical support from Novosoft. If you experience any problems installing or using our software that you can't solve by using this manual, or have any questions or suggestions, please contact Technical Support.

**For registered users:** Free technical support by email.

We guarantee response time - **2 business days**.

Patches, fixes, extended help and other related information.

registered@handybackup.net

**For unregistered users:** Limited technical support by email.

Response time - **3 business days**.

support@handybackup.net

To make sure that our support response letter is not deleted by spam filters, don't forget to add registered@handybackup.net and support@handybackup.net to your email address book.

You can also contact us via **instant messengers** or **phone** to receive instant response (we are at GMT+6, EST +11):

486-152-064

**Windows Live (MSN):** support@novosoft.net

**Skype:** NovosoftHelp

+7 (383) 330-3469

+1 (707) 703-1315

Also you can use our online feedback form which is available at http://www.handybackup.net/support.shtml.

Before sending a message to our Support Team, please download and install the latest build of the Handy Backup. It is highly possible that your problem has been fixed already. Please close the Handy Backup agent and the program before installation. The program can be downloaded at http://www.handybackup.net/download.shtml free of charge.

When sending a support request, please include the following information in it:

**If the program is running:**

- The backup software version and build date
- Your Windows version, build and the service pack number
- Please describe as precisely as you can what you were doing before the error occurred
- Please describe (or send us some screenshots with) the settings of the task on which the error occurred.
The log file will also be appreciated. To get the log file, simply right-click on the lowest pane, click on save file, and send us the file.

If the program does not run:

- The backup software version and build date
- Your Windows version, build and the service pack number
- Please describe (or send us a screenshot with) the error message
Handy Backup Installation

Handy Backup can be downloaded from the product website http://www.handybackup.net free of charge. The installation file is common for all editions of the program, including Handy Backup Server.

- **Before you install Handy Backup, make sure that your user account has administrative rights on the computer.**

To install Handy Backup or Handy Backup Server on your computer, follow these steps:

1. Launch the Handy Backup installation file (handybackup_setup.msi).

**Note:** Some users experience problems with launching the Microsoft Windows Installer (MSI) files. The support for MSI files depends on your OS and the version of Windows Installer used in your system.

If Windows Explorer claims that nothing is assigned to the .MSI extension, try one of the following things:

- **In Start menu, click Run…, type “msiexec.exe /i”, browse for handybackup_setup.msi, and then click OK. The resulting command should look like this:**

  msiexec.exe /i “C:\Downloads\handybackup_setup.msi”

- **Install the latest version of Windows Installer from the Windows update website http://windowsupdate.microsoft.com and launch the installation file via Windows Explorer.**

2. When the Handy Backup Setup Wizard opens, click Next.

3. Read the license agreement, and then click Next. The application selection window will open.
4. Select the application you want to install.

Select **Handy Backup** to install local version of the program. This option is common for all Handy Backup editions: Handy Backup Standard, Handy Backup Standard + DVD, Handy Backup Professional and Handy Backup Full. Select **Handy Backup Server** to install server edition of Handy Backup, or **Backup Network Workstation** to install backup workstations. For more details on installing Handy Backup Server, refer to **Installation of Handy Backup Server** on page 45.

5. Click **Next**.

6. Select the destination folder for installation, and then click **Next**.

7. Click **Install**.

   Handy Backup will be installed on your computer. The program doesn’t require a reboot, so you can run it right after the installation is finished.

8. Check **Run Handy Backup** to launch the application after finishing the installation. Check **Show Readme** if you would like to see the full list of features. Click **Finish**.

---

### Updating from Earlier Versions

Handy Backup is constantly developing to keep in step with the evolving computer technologies. The latest version of the program is always available for download at the product website [http://www.handybackup.net](http://www.handybackup.net). To update Handy Backup and preserve all scheduled and finished tasks, you need to uninstall older version and install a new one. Follow these steps:

1. Close the application and the agent.

   On the **File** menu, click **Exit** to close Handy Backup, and then right-click the Handy Backup Agent in system tray and click **Exit**. The agent icon will disappear.

2. In Start menu, select All Programs -> Handy Backup -> Uninstall Handy Backup, or in Control Panel, open **Change or Remove Programs**, select Handy Backup, and then click **Change/Remove**.

3. Click **Yes** when a warning window appears.

   If you are upgrading from Handy Backup version 5.8 or lower, the application will allow you to select if you want to remove registration information, tasks and logs, and settings. Do not check any boxes. For version 6.0 or higher, this data will be kept in your system automatically.

4. (In versions 5.8 and lower) Click **Uninstall**.

   Handy Backup will be removed from your system.

5. Install the new version of Handy Backup. It will retain all tasks and settings of the old version.

   For more details on installation, refer to **Handy Backup Installation** on page 13.

---

### System Requirements

Handy Backup is not a resource-consuming utility and has a very moderate list of system requirements.

**Windows operating systems:**

- Windows 2000 Professional/Server
- Windows 2003 Server/Standard/Web/Enterprise
Windows XP Home/Professional
Windows Vista Home Basic/Home Premium/Business/Enterprise/Ultimate
Windows 2008 Server

Handy Backup is certified with the Microsoft “Works with Windows Vista” logo which ensures that the program has been tested by Microsoft® for baseline compatibility with PCs running the Windows Vista™ operating system.

Available hard disk space:
- Approximately 23MB for Handy Backup
- Approximately 25MB for Handy Backup Server
- Approximately 9MB for Backup Network Workstation

Hardware requirements:
- 256MB RAM or more
- CPU: Pentium 300 MHz or higher
- Mouse (recommended)

Supported file systems:
- FAT16
- FAT16X
- FAT32
- FAT32X
- NTFS

Supported Storage Media
- Local hard disk drives
- External hard disk drives
- USB 1.0 / 2.0, FireWire (IEEE-1394) drives
- Floppy Disks, CD-R/RW, DVD±R/RW, Blu-Ray, HD DVD
- ZIP®, JAZ®, MO® and other removable media
- Flash USB memory drives
- Local Area Network drives
- Remote FTP/SFTP servers
- Remote Backup Service*

Remote Backup Service provides the most reliable way to protect your data by storing it on remote servers located in our secured underground shelters. To learn more about Novosoft Remote Backup Service, please visit [http://www.remotedatabackup.net/](http://www.remotedatabackup.net/).
First Start

First time you run Handy Backup, a welcome dialogue will be displayed.

The application will offer to start a trial period. The trial period is necessary to begin working with the program. However, you may register the application any time within or after 30 days of the trial period.

Registration

Handy Backup is a shareware. During the trial period you can enjoy all of its features including additional upgrades. But when the trial period expires the program must be registered. Handy Backup can be registered in two ways: online (requires Internet connection) or via e-mail.

To register Handy Backup, follow these steps:

1. On the Help menu click Enter your serial number, or click the Register now! button on the program toolbar. A registration window will appear.

2. Enter your serial number. If you are connected to the Internet, click Register. Otherwise, click Register by e-mail.

If you choose registration by e-mail, the application will generate a message with all necessary information and open it in your default e-mail client. If you don’t have an e-mail client, the registration information will be displayed in a new dialog window. You will need to send this information to support@handybackup.net. Upon receipt, we will send you a ZIP archive with a registration file. To complete the registration, you will need to extract it and open it on your computer.
**Note:** The registration e-mail contains strict information about the computer where your Handy Backup copy is installed. This information is essential for the process of registration, and will not be given away. The application is registered to a specific computer and cannot be used on other machines, so the file sent in return can be applied to your computer only. If you decide to purchase a new computer and want to continue using our program, you will need to send your registration key to our support team and we will either extend your current license to be fully functional on new hardware or send you a new registration key.

If you experience any problems while registering your copy of Handy Backup, please send a letter to support@handybackup.net. We will be happy to assist you with the registration.

**Checking the registration**

- To check the registration status, click the **Help** menu, and then click **About Handy Backup**.

If you are using a registered version of the product, you will see your license number.

**Uninstalling**

To uninstall Handy Backup, follow these steps:

1. Close the application.

On the **File** menu, click **Exit**, or right-click the Handy Backup Agent in system tray, and then click **Exit**. The agent icon will disappear.

2. In Start menu, select All Programs -> Handy Backup -> Uninstall Handy Backup, or in Control Panel, open **Change or Remove Programs**, select Handy Backup, and then click **Change/Remove**.

3. Click **Yes** when a warning window appears.

4. Check the desired boxes to select components to be removed with the application, and then click **Uninstall**.
Handy Backup Basics

Operation Types

Handy Backup allows you to perform three types of operations: backup, restore and synchronization.

Backup

Backup task is the most frequently used type of operation. It is used to copy your important data to another storage location. If files at the original location happen to get corrupted or deleted, you will be able to restore them from their backup copies. Handy Backup features two types of backup:

- **Full backup** – the program copies all selected data to the destination folder each time the backup task is executed;
- **Incremental backup** – the program checks for changes in file sizes or modification times since the previous backup, and copies only those files that have been altered. Advantages of this backup type are quite obvious: fewer amounts of data to operate with and noticeably less time to perform the operation.

Handy Backup supports two principal backup technologies: **files-based backup** and **image-based backup**. While files-based backup can be used to copy data represented in the file system as separate files only, image-based backup allows you to perform physical duplicating of your disk and create drive images that contain all system data. To learn more about image-based backup, refer to Image Backup on page 92.

**Note:** If you select incremental backup when backing up for the first time, the program will perform a full backup. The next time you will launch the task, it will perform incremental backup.

Restore

Restore task is used for restoring data from a backup copy if the original data is for some reason lost or corrupted. Handy Backup can perform two types of restore:

- **Full restore** – the program will restore the whole data set each time the restore task is executed;
- **Incremental restore** – the program checks for changes in file sizes or modification times since the previous restore, and restores only those files that have been altered.

Handy Backup allows you to restore your data to their original locations, or select any different local or network location.

Synchronization

Synchronization task is used to sync files between two different locations (for example, your home and office machine). You can also synchronize data with a remote FTP server. Handy Backup can perform three types of synchronization:

- **Copying from the first folder to the second** – the program copies files/folders from the first folder to the second;
• **Copying from the second folder to the first** – the program copies files/folders from the second folder to the first;

• **Mirroring both folders** – the program makes contents of both folders identical.

Synchronization task has several options that allow specifying files priorities, using file masks for files selection, etc.

### Tasks

Handy Backup organizes data in tasks. To backup, restore or synchronize your data, you have to create a task with the help of the **New Task Wizard**. All tasks have four common parameters:

- **Type of operation**: backup, restore, or synchronization;
- **Set of folders and files to process**;
- **Scheduling** - when and how often the task must be executed;
- **Actions** - running external applications before or after task execution;
- **Unique task name**.

Backup and Restore tasks have several other common options:

- **Type of backup/restore**;
- **Backup/restore destination**.

For a backup task there is also a number of specific options, such backup compression, encryption, etc.

All created tasks are shown in the Task View window, and can be easily modified or deleted.

### Creating New Task

New tasks are created with the help of the **New Task Wizard** which can be opened in three ways:

- **On the File menu**, click **New Task**.
- **Click the New Task button** on the program toolbar.
- **Right-click in the Task View window** to see the shortcut menu, and then click **New Task**.

The **New Task Wizard** works on the step-by-step basis. In the first step you need to select whether you are going to perform backup, restore or synchronization of your data. Backup task can be created in two ways: either using simple Standard mode or switching to more complex Expert mode, recommended for advanced users.

For more details on creating a new task, see **Managing data with Handy Backup** on page 23.

### Modifying Task

Viewing or modifying task properties can be done in several ways:

- **Double-click the desired task in the Task View window**.
• Right-click the desired task in the Task View window to see the shortcut menu, and then click Properties.

• Select the desired task in the Task View window, and then click the Task Properties button on the program toolbar.

• Select the desired task in the Task View window, click the File menu, and then click Properties.

• Select the desired task in the Task View window, and then press ALT-ENTER.

Task Properties dialog will appear. The window is divided into six (for Restore or Synchronize tasks) or seven (for Backup task) tabs that contain settings assigned during the task creation. Task creation is performed with the help of the New Task Wizard and is described in details in Managing data with Handy Backup on page 23. The Actions tab contains settings that allow performing certain actions before or after executing the task. To learn more, refer to Task Properties on page 67.

• After you have finished the modifications, click OK.

Duplicating Task

Duplicating tasks can be useful if you want to create a task very similar to an existing one. For instance, you may want to perform data backup to two different locations at once – duplicating the existing task and changing backup destination can be very time-saving in comparison with creating a new task. Duplicating task can be done in two ways:

• Select the desired task in the Task View window, click the File menu, and then click Duplicate.

• Right-click the desired task in the Task View window to see the shortcut menu, and then click Duplicate.

This procedure can also be applied to several tasks at once. To duplicate more than one task, select all needed tasks with the help of the standard Windows selection methods (use CTRL to select a single task, SHIFT to select a row of consecutive tasks, etc.), and then perform one of the above actions.

Each duplicated task will be named Copy #<number> of <original task name>. This name can be changed in Task Properties. For more details, see Modifying task on page 19.

Running Task

There are four ways to execute a task:

1. If you check Run now or Execute this task immediately during the task creation in the New Task Wizard, it will be executed straight away as you click Finish.

2. If you specify a schedule for the task, it will be executed automatically at the appointed time.


4. Execution through the use of the command line.

The first two ways are assigned within the New Task Wizard and are described in details in Managing data with Handy Backup on page 23. To execute tasks manually you need to perform one of the following actions:

• Right-click the desired task in the Task View window to see the shortcut menu, and then click Execute.
• Select the desired task in the Task View window, and then click the **Execute Task** button on the program toolbar.

• Select the desired task in the Task View window, click the **File** menu, and then click **Execute**.

• Select the desired task in the Task View window, click the **Actions** menu, and then click **Backup, Restore or Synchronize** (depending on the type of the task you selected).

• Select the desired task in the Task View window, and then press **CTRL-F5**.

This procedure can also be applied to several tasks at once. To execute more than one task, select all needed tasks with the help of the standard Windows selection methods (use **CTRL** to select a single task, **SHIFT** to select a row of consecutive tasks, etc.), and then perform one of the above actions. If selected tasks for some reason can’t be executed simultaneously (e.g. if one of them is already running), the commands in menus and on the toolbar will be disabled.

You can also execute one or several tasks through the use of the command line:

• Run Handy Backup Agent (backup.exe) with the **–e <tasks>** parameter. To learn more, refer to **Command Line** on page 89.

Task status is shown in the Task Window. It may be **Success, Error, Idle, Running, Stopped** or **Scheduled**.

### Stopping Task

There are several ways to interrupt task execution:

• Right-click the desired task in the Task View window to see the shortcut menu, and then click **Stop**.

• Select the desired task in the Task View window, and then click the **Stop Task** button on the program toolbar.

• Select the desired task in the Task View window, and then press **ESC**.

• Select the desired task in the Task View window, click the **File** menu, and then click **Stop**.

• Run Handy Backup Agent (backup.exe) with the **–s <tasks>** parameter. To learn more, refer to **Command Line** on page 89.

This procedure can also be applied to several running tasks at once. To stop more than one task, select all needed tasks with the help of the standard Windows selection methods (use **CTRL** to select a single task, **SHIFT** to select a row of consecutive tasks, etc.), and then perform one of the above actions. If selected tasks for some reason can’t be stopped simultaneously (e.g. if one of them is not running), the commands in menus and on the toolbar will be disabled.

**Note:** In some cases this procedure can take several minutes.

### Deleting Task

Task deletion can be done in several ways:

• Right-click the desired task in the Task View window to see the shortcut menu, and then click **Delete**.
• Select the desired task in the Task View window, and then click the Delete Task button on the program toolbar.

• Select the desired task in the Task View window, and then press DEL.

• Select the desired task in the Task View window, click the File menu, and then click Delete.

• Run Handy Backup Agent (backup.exe) with the \(-d <tasks>\) parameter. To learn more, refer to Command Line on page 89.

Note: If you delete a task, your files and folders won’t be deleted either from their original location, or from their backup location.
Managing Data with Handy Backup

To back up, restore or synchronize your data, a respective task should be created. This is done through the use of the New Task Wizard which guides you through the processes of Backup, Restore and Synchronize task creation.

Backing Up Data

There are two ways to back up your data. Firstly, you can create a backup task. This is done with the help of the New Task Wizard which can be opened in three ways:

- Click the New Task button on the program toolbar.
- Right-click in the Task View window to see the shortcut menu, and then click New Task.

Backup tasks can be created in two modes:

- **Standard mode**: Standard mode has a minimal set of options and provides a fast way to create a backup task.
- **Expert mode**: Expert mode is designed for experienced users and allows adjusting an extended set of options.

Each time a backup task is executed (manually or on a schedule) all data included into the backup set will be saved. However, if you don’t want to back up the whole data set, you can back up any separate file or a set of files included into any existing backup task. To do it, follow these steps:

1. In the Task View window select the task that includes files or folders you want to back up.
2. In the File View window select the needed files and folders with the help of the standard Windows selection methods (use CTRL to select a single task, SHIFT to select a row of consecutive tasks, etc.).
3. Right-click on any of the selected items to open the shortcut menu, and then click Backup.

The files you selected will be backed up to the location specified in the backup task.

Standard Mode

Standard mode provides the easiest way to create a backup task with the minimal set of backup options. All you need to do is to follow the instructions of the New Task Wizard.

Creating backup task in Standard Mode suggests you to complete nine steps:

- **Step 1: Choose Task Type** is described on page 24.
- **Step 2: What to Backup?** is described on page 24.
- **Step 3: Backup Type** is described on page 27.
• **Step 4: Select Destination** is described on page 27.

• **Step 5: How to Backup?** is described on page 34.

• **Step 6: When to Backup?** is described on page 35.

• **Step 7: How Often to Backup?** is described on page 35.

• **Step 8: What Time to Backup?** is described on page 36.

• **Step 9: Name the Backup Task** is described on page 38.

**Step 1: Choose Task Type**

In the first step of the **New Task Wizard** you need to select the type of the task you are going to create:

- Select **Backup task**, and then click **Next**.

**Step 2: What to Backup**

In the second step of the **New Task Wizard** you need to select files/folders to be backed up. To add data to backup set, follow these steps:

1. Click **Add** to open the shortcut menu. The list of available for backup items will appear.
2. Select the item that you want to add to the backup set. It will appear in the Backup Set box.

If an item (e.g. folder) contains subitems, they will be automatically included into the backup set. You may use a tree panel near the item to include or exclude them from the backup set by checking or unchecking the respective checkboxes. To exclude all subitems, uncheck the box near the root item.

Black checkmark indicates that the entire item is included in the backup set. Gray checkmark shows that one or more subitems are excluded. Each item or subitem will be backed up only if the checkbox near it is checked.

3. When finished, click Next.

**Description of backup items**

**Folder:** In the **Browse for Folder** dialog box, select a folder or a whole drive, and then click **OK**. It will be added to the backup set with all subfolders and files. To exclude any of them from the backup set, expand the tree panel and uncheck the respective boxes.

Repeat the procedure to add all needed folders on all hard drives.
Files: In the Select File dialog box, select a file or files, and then click Open.

The Select File dialog allows selecting multiple files from one folder only. Repeat the procedure for each folder you want to add files from.

FTP Files: In the FTP Settings dialog box, specify the FTP server, enter your login and password and indicate the exact location of needed files. If you cannot do it manually, click the Browse button and select the needed files in the Select File dialog box. Click OK.

ICQ Files, Registry, Favorites, Desktop, My Documents, Microsoft Outlook Files, Outlook Express Files: These items represent explicit program presets, designed to back up data and settings of different popular applications. The application will automatically search for the needed data and add it to the backup set.

Database, Disk Image, Email Messages, MS Exchange: These items are Handy Backup plug-ins, designed to back up databases, perform image backup, etc. For details, refer to Backup Extras on page 90.

More…: This item allows you to download other presets for popular applications from the Handy Backup website. For details, refer to Plug-Ins on page 105.
Removing items from the backup set

Removing from backup set applies to root items only, i.e. it can’t be done to a subitem of other backup item. To exclude subitems (e.g. subfolders and files), use checkboxes. To remove a root item from the backup set, follow these steps:

1. Select the desired item in the Backup Set box.
2. Click Remove.

Step 3: Backup Type

In the third step of the New Task Wizard you need to select the type of backup task. There are two types of backup: full and incremental.

- Select the desired type of backup, and then click Next.

Full backup: The application will back up all selected files each time the task is executed.

Incremental backup: The application will back up only those files that have changed since the last task execution.

Step 4: Select Destination

In this step of the New Task Wizard you need to select a destination folder where your backup will be stored.
Select the backup destination, and then click Next.

You can choose between six locations:

- **Local Disk/External HDD/USB Disk/Flash/LAN** is described on page 28.
- **FTP** is described on page 29.
- **SFTP** is described on page 31.
- **CD-R/CD-RW** is described on page 31.
- **Blu-Ray/HD-DVD/DVD** is described on page 32.
- **Handy Backup Online** is described on page 33.

These locations are described in details in six following sections.

**Note:** When you complete all steps of the **New Task Wizard** and launch the task, Handy Backup will create a folder with the same name as the task name (see **Step 9: Name the Backup Task** on page 38) to store the data. You can change the destination folder by modifying task settings (see **Modifying task** on page 19), but this must be done carefully, because in this case no new folder will be created. When selecting new destinations, make sure that you always have different folders for different tasks. If you select a single destination folder for several backup tasks, you will be able to restore only the last one. The matter is that each successive index file will overwrite the previous index file.

**Backup to Local Disk/ External HDD/ USB Disk/ Flash/ Lan**

- Select **Local Disk/External HDD/USB Disk/Flash/LAN** to back up to any local or external drive seen by Windows Explorer.
• Type a path or click the **Browse for folder** button to browse for the desired destination folder.

**Backup to FTP**
• Select FTP to store your backups at a remote FTP server.

To back up to FTP you will need to specify **Host**, **Port**, **User**, **Password**, **Location** and **Proxy** settings.

• **Host**: Enter the FTP server name.
• **Port**: Enter the port number. The default value is 21.
• **User**: Enter your FTP user name.
• **Password**: Enter your FTP password.
• **Location:** Type a path of a remote directory to store your backup to, or click the **Select FTP folder** button to select it via the **Select FTP folder** dialog.

The **Select FTP folder** dialog window consists of two parts. The upper part contains the list of folders available on the FTP server, while the other shows the FTP session log messages. After establishing an FTP connection, the list of remote directories will appear. Select the desired directory, and then click **Select**. To create a new directory, click **New folder**.

• Click **Proxy** if your computer is inside a firewall. The **Proxy server settings** dialog will appear.

1. Check **Use FTP proxy** if you want to use FTP proxy. Specify FTP proxy host and, if necessary, authorization data.

2. Check **Use SOCKS server** if you want to use SOCKS server. Select type of the SOCKS server, specify the server name and, if necessary, authorization data.

3. When finished, click **OK**.
• Click **Try in passive mode** to initiate the FTP connection, rather than relying on the remote server to set it up. This may be necessary if a firewall does not allow establishing a connection from the outside.

**Backup to SFTP**

• Select SFTP to store your backups on a secure SFTP server.

![Image of SFTP settings](image)

The process of backing up to SFTP is very similar to backing up to FTP, except that **Port** is 22, and **Proxy** and **Try in passive mode** are unavailable. To back up to SFTP you will need to specify **Host**, **Port**, **User**, **Password** and **Location**. For details, refer to **Backup to FTP** on page 29.

**Note:** By default, the **Backup to SFTP** feature is included into **Handy Backup Professional** edition. If you want use this feature within the Handy Backup Standard functionality you need to purchase it as an additional upgrade. The latest information about upgrades is always available in the **Order** section on the product website: [http://www.handybackup.net/order.shtml](http://www.handybackup.net/order.shtml).

**Backup to CD-R/CD-RW**

• Select **CD-R/CD-RW** to burn your backups to a compact disk.
To configure the process of backing up to CD, specify the following options:

- **Device**: Choose your CD-R/CD-RW device.

- **Folder**: Type the name of the folder where you want to back up your data to. Note that the length of each folder and subfolder must not exceed 64 characters, or contain one of the following characters: * ? : ; .

- **Speed**: Choose the necessary CD recording speed. Lower speed decreases probability of writing errors.

- Check **Enable spanning (split large backups)** to enable data spanning – a procedure of splitting backups to fit several discs. This is essential if your backup set requires more space than it is available on a single CD. Files split by this procedure will be named XXXXname, where X is a hexadecimal digit.

- Check **Erase disk before writing** if you need to erase a CD-RW disc before burning the backup.

**Note**: You can either use a blank (brand-new) CD-R/W disc, or erase discs if they were previously formatted with a 3rd party program like DirectCD.

**Note**: If you want to verify the backup after burning you need to check the respective box in **General Settings** (see page 71 for details). With this option checked, the application will automatically verify if the data burned on CD/DVD is readable.

**Backup to Blu-Ray/HD-DVD/DVD**

- Select **Blu-Ray/HD-DVD/DVD** to burn your backups to one of these media.

This option is universal and can be used for backing up to CD as well.

To configure the process of backing up to DVD, specify the following options:

- **Device**: Choose your Blu-Ray, HD-DVD or DVD device.

- **Folder**: Type the name of the folder where you want to back up your data to. Note that the length of each folder and subfolder must not exceed 64 characters, or contain one of the following characters: * ? : ; .
• **Disk size:** Choose your storage disk size.

• **Speed:** Choose the necessary DVD recording speed. Lower speed decreases probability of writing errors.

• Check **Enable spanning (split large backups)** to enable data spanning – a procedure of splitting backups to fit several discs. This is essential if your backup set requires more space than it is available on a single disk. Files split by this procedure will be named \textit{XXXXname}, where \textit{X} is a hexadecimal digit.

• Check **Erase disk before writing** if you need to erase a Blu-ray, HD-DVD, DVD-RW disk before burning the backup.

**Note:** If you want to verify the backup after burning you need to check the respective box in General Settings (see page 71 for details). With this option checked, the application will automatically verify if the data burned on CD/DVD is readable.

**Note:** By default, the Backup to DVD feature is included into Handy Backup Standard+DVD edition. If you want to add this feature to the Handy Backup Standard functionality you need to purchase it as an additional upgrade. The latest information about upgrades is always available in the Order section on the product website: [http://www.handybackup.net/order.shtml](http://www.handybackup.net/order.shtml).

**Handy Backup Online**

• Select **Handy Backup Online** to store your backups on your Novosoft Remote Backup Service account.

To use the Online Backup Service, you need to register an account. To do it, click the **About Online Backup Service** link which will open your default web browser and take you to the web page where you will be able to choose an appropriate storage plan and register your account. You can also access this page at the following URL: [http://www.handybackup.net/online-backup.shtml](http://www.handybackup.net/online-backup.shtml).

To configure online backup, specify the following options:

• **User:** Enter your login name.

• **Password:** Enter your password.

• **Description** (optionally): Write a brief description of your backup set.
• Click **Proxy** if your computer is inside a firewall. The **Proxy server settings** dialog will appear.

1. Check **Use FTP proxy** if you want to use FTP proxy. Specify FTP proxy host and, if necessary, authorization data.

2. Check **Use SOCKS server** if you want to use SOCKS server. Select type of the SOCKS server, specify the server name and, if necessary, authorization data.

3. When finished, click **OK**.

All Handy Backup users can use the Backup Online Service by registering a free 100, 200 or 500 Mb account. For users of the trial version of the program this account will be accessible for 10 days. However, if you purchase a Handy Backup license the free account validity period will be extended to 30 days. To register a free trial account, click **Get Sample Account** or visit [http://www.handybackup.net/get-online-backup-trial.shtml](http://www.handybackup.net/get-online-backup-trial.shtml).

**Step 5: How to Backup**

In this step of the **New Task Wizard** you can enable compression and encryption.
1. Check **Compress the data to save space** to enable an integrated ZIP compressor. This option is recommended when you back up to network drives or FTP servers in order to save storage space and online time.

2. Check **Encrypt the data for security reasons** to encrypt the backup with blowfish encryption algorithm and make the data inaccessible to anybody who does not know the password.

If you choose to encrypt the data, the following fields are to be filled:

- **Password**: Enter the encryption password.
- **Confirm password**: Confirm the encryption password entered in the previous field.

**Note**: All passwords are case-sensitive.

3. When finished, click **Next**.

**Step 6: When to Backup**

In this step of the **New Task Wizard** you can enable scheduling:

1. Check **Run now** to execute the task immediately after the task is created.

2. Check **Setup schedule** to set up a backup schedule.

3. When finished, click **Next**.

If **Setup schedule** was not checked, you will be forwarded straight to the final step of the task creation, otherwise you have to complete 7th and 8th steps.

**Step 7: How Often to Backup**

In this step of the **New Task Wizard** you need to adjust the period of time over which the task will be repeated. This step is available only if you selected **Setup schedule** in the previous step.
1. Select how often you want the task to be performed:
   - **Once**: the task will be scheduled to run once at the specified time
   - **Daily**: the task will be scheduled to be performed daily at the specified time
   - **Weekly**: the task will be scheduled to be performed weekly at the specified day
   - **Monthly**: the task will be scheduled to be performed monthly at the specified date.

2. When finished, click **Next**.

**Step 8: What Time to Backup**

In this step of the **New Task Wizard** you need to provide exact time or date for task scheduling. It depends on your selection in the previous step.

- If you have selected **Once** in the previous step, you will be prompted to specify the date and time of backup. To change day, month, year, hour, minute and second, click them and enter new values, or use the ↑ or ↓ keys to increase or decrease them.
• If you have selected **Daily** in the previous step, you will be prompted to specify the time of backup. To change hour, minute or second, click them and enter new values, or use the ↑ and ↓ keys to increase or decrease them.

![Image of Handy Backup User Manual](image1.png)

• If you have selected **Weekly** in the previous step, you will be prompted to select the day of the week to perform the backup task.

![Image of Handy Backup User Manual](image2.png)

• If you have selected **Monthly** in the previous step, you will be prompted to select the day of the month.

![Image of Handy Backup User Manual](image3.png)
To ensure consistency of your backups, select a day that exists in all months. For example, selecting 30th day will result in omission of task execution in February.

- When finished, click **Next**.

**Step 9: Name the Backup Task**

In the last step of the **New Task Wizard** you need to name your backup task.

1. Enter a unique task name in the text field.

2. Check the properties of the newly created task in the box below the name field. If one or more settings are incorrect, click **Back** to return to previous steps and change the needed parameters. If the task is not intended to be performed right after the creation, you can modify its properties later. To learn about modifying tasks, refer to **Modifying Task** on page 19.
3. Click **Finish**.

The newly created task will appear in the Task View window. If you checked **Run now** in Step 6 of the **New Task Wizard**, it will be executed immediately. If **Run now** was not checked, it will be executed on schedule or on demand. To learn more, refer to **Running task** on page 20.

**Expert Mode**

**Expert Backup Mode** offers a more powerful and flexible way to setup the backup process. It is recommended for experienced computer users and includes many new options in the **New Task Wizard**.

Creating backup task in Expert Mode suggests you to complete seven steps:

- **Step 1: Choose Task Type** is described on page 39.
- **Step 2: Specify Backup Set** is described on page 40.
- **Step 3: Select Destination** is described on page 41.
- **Step 4: Advanced Backup Settings** is described on page 41.
- **Step 5: Compression and Encryption** is described on page 42.
- **Step 6: Scheduling** is described on page 43.
- **Step 7: Ready to Create New Task** is described on page 44.

**Step 1: Choose Task Type**

In the first step of the **New Task Wizard** you need to select the type of the task you are going to create.

1. Select **Backup task**.
2. Check **Expert Mode** (unchecked by default).
3. Click **Next**.
Step 2: Specify Backup Set

In the second step of the New Task Wizard you need to select files and folders to back up. This step is similar to Step 2 in Standard mode described on page 24, but allows setting up additional conditions for files selection.

1. Click **Add** to open the shortcut menu. The list of available for backup items will appear.
2. Select the item that you want to add to the backup set. It will appear in the Backup Set box.
3. Specify include and exclude masks to select files to be included in the backup set. You may enter full file names separated by a semicolon, or/and specify masks indicating groups of files. The rules for masks are the following:
   - Use the asterisk symbol ‘*’ to replace a set of characters;
   - Use a question mark ‘?’ to replace a single character.

   For instance, "*.exe" stands for files with the "exe" extension only; empty line (or "*.*) will add all files. The application has explicit preset to add excluding mask for common temporary extensions.

4. If you want to add excluding mask for common temporary extensions, click **Add default temporary extensions**.
5. To make masks relevant for folders, check **Apply these masks to folders as well as to files**.
6. When finished, click **Next**.
Step 3: Select Destination

In the third step of the New Task Wizard you need to select destination for your backup. This step is absolutely identical to Step 4 in Standard mode described on page 27.

Step 4: Advanced Backup Settings

In this step of the New Task Wizard you need to select what type of backup you are going to perform: full or incremental. Also, you may set up additional features that are not available in Standard Mode.

1. Select backup type.

Similar to Standard mode, backup type can be chosen from two options:

- **Full backup**: The program will backup all the files on every backup session.

- **Incremental backup**: The program will backup only the files that have been changed since the last backup session.

The other options belong to advanced backup configuration and are available in Expert mode only.

2. Check **Delete all files in the destination except those being backed up** to enable deletion of files in the destination folder that have no relation to the current backup task.

3. Check **Store backups with timestamps** to enable timestamps. Your backups will be provided with the information as to when they were created.

4. To define properties of time labeling, click **Timestamp format settings**. The Timestamps format settings window will appear.
4.1 Select the desired timestamp accuracy. You may select between month, week, day, hour or minute.

4.2 Select the timestamp format.

4.3 Choose how to treat older versions of backups. If you are creating a full backup task, you can keep them all, leave only certain number of latest versions, or keep old ones for a period of time. For incremental backup only the first option is available.

4.4 When finished, click OK.

5. Click File-specific settings to select how to treat different file types while backing up.

- Check Open files exclusively to prevent other applications address files during the backup process.

6. When finished, click Next.

**Step 5: Compression and Encryption**

In this step of the New Task Wizard you need to select compression and encryption options.
**Compression**

You may choose to compress your backup to a ZIP archive, which can be useful in terms of space or time (for instance, if you are backing up to a network drive or a FTP server, it will save storage space and online time).

To set backup compression, follow these steps:

1. Select compression type. **No compression** (default) leaves your data uncompressed, **ZIP compression (single file)** creates a single ZIP archive of your backup, **ZIP compression (multiple files)** creates separate ZIP files for each backed up file.

2. If you selected **ZIP compression (single file)**, specify the archive name.

3. Select compression quality. Higher quality reduces size of the archive, but requires more time for the compression.

**Encryption**

Encrypting the backup makes it password-protected, which means that the data can’t be restored by anyone who doesn’t know the password. Currently, Handy Backup supports only one encryption algorithm known as *blowfish*, which provides the highest level of protection used in Internet communications.

To set backup encryption, follow these steps:

1. Check **Encrypt**. Text fields below the box will become available.

2. Enter encryption password in the **Password** text field. Remember that the password is case-sensitive.

3. Confirm the password in the **Confirm Password** text field.

**Note:** Make sure that you remember your password, because if you forget it, you won’t be able to restore the backup, and even our support team won’t be able to help you.

4. When finished, click **Next**.

**Step 6: Scheduling**

In this step of the **New Task Wizard** you need to define the backup schedule. Backup may be performed once or on a regular basis.
1. Check **Enable scheduler** to perform backup task on time specified below.

2. Select the time you want the task to be launched at. To change day, month, year, hour, minute and second, click them and enter new values, or use the ↑ or ↓ keys to increase or decrease them.

3. Check **Repeat** if you want the task to be performed regularly.

There are four available options of repetition:

- **Every day** – Schedule the task to be performed daily at the foregoing time;
- **On week days** – Schedule the task to be performed on certain week days;
- **On month days** – Schedule the operation to be performed on certain month days;
- **Custom period** – Define the time period manually.

4. Check **Run the missed schedules** if you want Handy Backup execute this task if it has been missed (as soon as you log in).

5. Check **Run on logon** to execute this task each upon logging on.

6. Check **Run on logoff** to execute this task each upon logging off.

**Step 7: Ready to Create New Task**

In the last step of the **New Task Wizard** you need to name your backup task.

1. Enter a unique task name in the text field.

2. Check the properties of the newly created task in the box below the name field. If one or more settings are incorrect, click **Back** to return to previous steps and change the needed parameters. If the task is not intended to be performed right after the creation, you can modify its properties later. To learn about modifying tasks, refer to **Modifying Task** on page 19.

3. Check **Execute this task immediately** if you want to run the created task straight away after the completion. If the checkbox is not checked, the task will be executed on schedule specified in **Step 6**, or can be executed on demand. To learn more, refer to **Running task** on page 20.
4. Click Finish.

The newly created task will appear in the Task View window.

Once you've created and executed a Backup task, Handy Backup will create a corresponding index file (backup.hbi or spanXXXX.hbi in case of backup to CD/DVD, where XXXX is a hexadecimal number of span) containing information on the files included in this task. Index files are stored along with backup files. They are essential to perform restoration and synchronization tasks, don’t modify them manually.

**Network Backup**

Handy Backup Server is backup software designed to perform network backup. It allows performing centralized backup of network data, operated from a single server and invisible for users on remote workstations.

The usage of Handy Backup Server suggests the administrator to define a central server which will be used to create network backup tasks, and client workstations that contain data that needs to be backed up. In that way the backup network architecture is divided in two principal parts: Server (the central server with Handy Backup Server installed on it) and Backup Network Workstations (one or many remote computers with Backup Network Workstation client software installed on them).

Once the backup network is established, you can back up data of all Backup Network Workstations without specifically attending each machine to create a backup task.

**Installation**

The network backup components are installed in the following order. First you must install Handy Backup Server, then - Handy Backup Workstations.

**Note:** You can only install Handy Backup Workstations after Handy Backup Server has been installed.

**Installation of Handy Backup Server**

To install Handy Backup Server, launch the Handy Backup Server setup file. Handy Backup Server is installed the same way any other version of Handy Backup is installed. Read the instructions on Handy Backup installation.

**Installation of Handy Backup Workstation**

Backup Network Workstation is installed on a user machine and allows backing up data on this machine from a remote backup server where Handy Backup Server is installed. Handy Backup Workstation runs as Windows service.

- Create Handy Backup Workstation Setup file
- Install Handy Backup Workstation on the computer whose data you are going to back up
- Adjusting Handy Backup Workstation Settings after the Workstation is installed

**How to create Handy Backup Workstation Setup file**

When Handy Backup Server is successfully installed on your computer, you can create Backup Network Workstation.
Note: You can also use the default Handy Backup Workstation with predefined settings, which is stored in the Handy Backup Server installation directory (default path: "C:\Program Files\Novosoft\Handy Backup\Backup\Network Workstation\"). However, it is recommended to create Handy Backup Workstation by following the instructions below. This will allow you to adjust the Workstation settings more precisely.

- On the File menu, click New Workstation.

OR

- In Start menu, point to All programs, point to Handy Backup, and then click Create Backup Network Workstation.

The Backup Network Workstation Settings dialog will appear.
Server host name: Network name or IP-address of the machine where Handy Backup Server is installed.

Backup administrator login: The person who is authorized to do the backup from remote machines. By default this is the same person who installed Handy Backup Server. However, you can specify a different administrator.

Workstation name: Name of the Workstation being created. You can choose among three available options:

- The first option Automatically use computer name as Workstation name means that the Workstation will have the same name as the domain name of the remote computer where it is going to be installed.

- The second option Ask for the Workstation name while installing the program means that you will have to specify the Workstation name manually while installing it on a remote computer.

- The third option Use the Workstation name typed above allows you to specify any name for the Workstation. When you check this option, the Workstation name field will be activated and you will be able to type any name for the Workstation.

Note: Use the Load defaults button to fill all fields with their default values.

- After you have specified the Backup Network Workstation settings, click Create.

The Save as dialog will appear where you can select the location to save the Workstation setup file. You can save the Workstation setup file directly to the remote computer where it is going to be installed. Or you can save the Workstation setup file locally (by default this is the same folder as the Handy Backup Server installation directory) and then transfer it to the machine on which you want to install the Workstation.

How to install Handy Backup Workstation

To install Handy Backup Workstation, launch the Handy Backup Workstation Setup file.

Adjusting Handy Backup Workstation Settings after the Workstation is installed
To change the settings of Handy Backup Workstation, run the Backup Network Configuration file which is located in the Backup Network Workstation installation directory on a remote machine where Backup Network Workstation is installed. The Backup Network Workstation Settings dialog will appear.

If the **Start** button is disabled, it means that the Workstation is running. To change the settings of the Workstation, click **Stop**. The Workstation will be stopped.

Now you can change the Workstation settings.

- In the **Server host name** field, specify the network name of the machine where Handy Backup Server is installed.

- In the **Backup administrator** field specify the login name of the user who will be authorized to back up local data from a remote machine.

**Important note:** Handy Backup Server can only back up data from the Workstation machine when Handy Backup Workstation is running. To run Workstation with the new settings, click **Start**. Then you can shut down the Backup Network Workstation Settings dialog.

- In the **Workstation name** field, specify the name of the Workstation.

### Creating Network Backup Task

Once you have installed and configured Handy Backup Server and Handy Backup Workstations, you can back up data from each machine where Backup Network Workstation is installed. Creating backup task in Handy Backup Server is similar to creating usual backup task:

1. Launch the **New Task Wizard**.

2. Select **Backup Task**, and then click **Next**.

3. Click **Add** to open the shortcut menu. The list of available for backup items will appear.
4. Select **Backup Network**. Workstations will be added to the backup set.

Expand the tree panel to see the list of Handy Backup Workstations that are currently available for backup. To exclude one or several computers from the backup set, uncheck the respective boxes. By default, Handy Backup Server will perform full backup of all client computers hard drives. To exclude unneeded folders or files, expand the tree panel and uncheck the respective boxes.

5. When finished, click **Next**.

The subsequent steps are identical to usual backup task creation. For more details, refer to **Backing up data** on page 23.
Restoring Data

After successful completion of a backup task, Handy Backup creates an index file (*backup.hbi* or *spanXXXX.hbi* in case of backup to CD/DVD, where *XXXX* is a hexadecimal number of span). Index files are stored along with backup files and contain all information on the performed task. They are essential for restoration/synchronization purposes, and must not be modified manually.

There are two ways to restore backed up data. Firstly, you can create a restore task. This is done with the help of the **New Task Wizard** which can be opened in three ways:

- On the **File** menu, click **New Task**.
- Click the **New Task** button on the program toolbar.
- Right-click in the Task View window to see the shortcut menu, and then click **New Task**.

To create a restore task you need to complete seven steps:

1. **Step 1: Choose Task Type** is described on page 50.
2. **Step 2: Specify Index File** is described on page 51.
3. **Step 3: Select Restore Location** is described on page 54.
4. **Step 4: Advanced Restore Settings** is described on page 55.
5. **Step 5: Enter Password For Decryption (optional)** is described on page 55.
6. **Step 6: Scheduling** is described on page 56.
7. **Step 7: Ready To Create New Task** is described on page 57.

Besides restoration of the whole data set, you can also restore any separate file or a set of files included into any existing backup or restore task. This method is useful if you don’t want to restore the whole backup set, however it doesn’t let you restore files to locations different than original. To restore separate files and folders, follow these steps:

1. In the Task View window select the task that includes files you want to restore.
2. In the File View window select needed files and folders with the help of the standard Windows selection methods (use **CTRL** to select a single task, **SHIFT** to select a row of consecutive tasks, etc.).
3. Right-click on any of the selected items to open the shortcut menu, and then click **Restore**.

The files you selected will be restored to their original locations. For more details, refer to **Restoring Separate Files and Folders** on page 58.

**Step 1: Choose Task Type**

In the first step of the **New Task Wizard** you need to select the type of the task you are going to create.
• Select **Restore task**, and then click **Next**.

There is no Expert mode for this task, so as you select **Restore task**, the checkbox will become unavailable.

**Step 2: Specify Index File**

In the second step of the **New Task Wizard** you need to specify where your backup is stored.

• Select the location of the index file of the backup you want to restore, and then click **Next**.

You may choose between four locations.

**Restoring from a local/external/network/removable drive**

• Select **Local Disk/USB Disk/Flash/LAN/CD/HD-DVD/Blu-Ray** if the backup is stored on a local or external location seen by Windows Explorer.
Type a path or click the **Browse for folder** button to browse for the folder with the index file.

**Restoring from an FTP server**

- Select FTP if the backup is stored on a FTP server.

To restore from FTP you will need to specify **Host**, **Port**, **User**, **Password**, **Location** and **Proxy** settings.

- **Host**: Enter the FTP server name.
- **Port**: Enter the port number. The default value is 21.
- **User**: Enter your FTP user name.
- **Password**: Enter your FTP password.
- **Location**: Type a path of a remote directory that contains the index file, or click the **Select FTP folder** button to select it via the **Select FTP folder** dialog.
The Select FTP folder dialog window consists of two parts. The upper part contains the list of folders available on the FTP server, while the other shows the FTP session log messages. After establishing an FTP connection, the list of remote directories will appear. Select the desired directory, and then click Select. To create a new directory, click New folder.

1. Click Proxy if your computer is inside a firewall. The Proxy server settings dialog will appear.

2. Check Use FTP proxy if you want to use FTP proxy. Specify FTP proxy host and, if necessary, authorization data.

3. Check Use SOCKS server if you want to use SOCKS server. Select type of the SOCKS server, specify the server name and, if necessary, authorization data.

4. When finished, click OK.

   - Click Try in passive mode to initiate the FTP connection, rather than relying on the remote server to set it up. This may be necessary if a firewall does not allow establishing a connection from the outside.

Restoring from an SFTP server

- Select SFTP if the backup is stored on a secure SFTP server.

Restoring from SFTP server is very similar to restoring from FTP, except that Port is 22, and Proxy and Try in passive mode are unavailable. To restore from SFTP you will need to specify Host, Port, User, Password and Location.

Restoring from a Handy Backup Online account

- Select Handy Backup Online if the backup is stored on your Handy Backup Online account.
To use the Online Backup Service, you need to register an account. To do it, click the About Online Backup Service link which will open your default web browser and take you to the web page where you will be able to choose an appropriate storage plan and register your account. You can also access this page at the following URL: http://www.handybackup.net/online-backup.shtml.

To restore from your Online Backup Service account, specify the following options:

- **User**: Enter your login name.
- **Password**: Enter your password.
- **Description** (optionally): Write a brief description of your backup set.
- Click **Proxy** if your computer is inside a firewall. Specify settings of your proxy server.
- Click **Update** to download the list of tasks to restore, and then select the needed backup from the dropdown menu.

**Step 3: Select Restore Location**

In the third step of the New Task Wizard you need to decide where you want the backed up files to be restored to.

Handy Backup remembers the original destination of backed up data. By default, Handy Backup offers to restore the data to its original location.

To restore file to a different location, follow these steps:

1. Select the file in the list, and then click **Edit**…

2. Type a path or click the **Browse for folder** button to browse for the desired destination folder.

3. Click **OK**.

4. Repeat steps 1-3 for each file you want to restore to different locations.
To choose a different destination, click **Edit...**

**Step 4: Advanced Restore Settings**

In the fourth step of the **New Task Wizard** you need define if you want to perform full or partial restoration of your data.

1. Select the desired type of restoration.

There are two available types of restoration:

- **Full restore** – The program will copy every backed up file to the specified location, irrespective of presence of files with identical names. Even if the file was not changed since the last backup, it will be overwritten.

- **Incremental restore** – Only those files are restored which have been changed since the last backup. If Handy Backup detects a file in the directory with the same name, it compares the two files. If the file was changed it will be overwritten, otherwise it will not.

2. Check **Delete all files in the destination except those being restored** to enable deletion of files in the destination folder that have no relation to the current backup task.

3. Click **Next**.

**Step 5: Enter Password for Decryption (optional)**

This step of the **New Task Wizard** will appear if you are restoring an encrypted backup only. Otherwise it will be skipped.
• Type the password that you used to encrypt files during backup task creation, and then click **Next**.

**Step 6: Scheduling**

In this step of the **New Task Wizard** you need to define the schedule for restoring. Restore task may be performed once or on a regular basis.

1. Check **Enable scheduler** to perform restore task on time specified below.

2. Select the time you want the task to be launched at. To change day, month, year, hour, minute and second, click them and enter new values, or use the ↑ or ↓ keys to increase or decrease them.

3. Check **Repeat** if you want the task to be performed regularly.

There are four available options of repetition:
• Every day – Schedule the task to be performed daily at the foregoing time;

• On week days – Schedule the task to be performed on certain week days;

• On month days – Schedule the operation to be performed on certain month days;

• Custom period – Define the time period manually.

4. Check *Run the missed schedules* if you want Handy Backup to execute this task if it has been missed (as soon as you log in).

5. Check *Run on logon* to execute this task each upon logging on.

6. Check *Run on logoff* to execute this task each upon logging off.

**Step 7: Ready to Create New Task**

In the last step of the New Task Wizard you need to name your restore task.

1. Enter a unique task name in the text field.

2. Check the properties of the newly created task in the box below the name field. If one or more settings are incorrect, click *Back* to return to previous steps and change the needed parameters. If the task is not intended to be performed right after the creation, you can modify its properties later. To learn about modifying tasks, refer to *Modifying Task* on page 19.

3. Check *Execute this task immediately* if you want to run the created task straight away after the completion. If the checkbox is not checked, the task will be executed on schedule specified in *Step 6* (described on page 56), or can be executed on demand. To learn more, refer to *Running task* on page 20.

4. Click *Finish*.

The newly created task will appear in the Task View window.
Handy Backup allows performing restoration of separate files and folders that are included in other backup or restore tasks created in the program.

1. In the Task View window select backup or restore task that includes files you want to restore. All items included into the task’s backup set will be displayed in the File View window.

2. In the File View window select needed files and folders with the help of the standard Windows selection methods (use **CTRL** to select a single task, **SHIFT** to select a row of consecutive tasks, etc.).

3. To restore a file or a subfolder contained in a backed up folder, double-click it in the File View window, and then do the selection procedure.

**Note:** If the backup set was formed with the use of backup presets, such as *<My Documents>* or *<Favorites>* , this method can’t be used. You can restore separate files from folders that were backed up as *Folder...* backup item during the task creation. For more details refer to Step 2: What to backup of backup task creation on page 24.

4. Right-click on any of the selected items to open the shortcut menu, and then click **Restore**.

The procedure of restoring separate files and folders through the File View Window doesn’t allow you to perform restoration to locations different than those defined in the task. If you want to change restore location for your data, you need to edit the task first. To learn about modifying tasks, refer to Modifying Task on page 19. For more details about the File View Window, refer to File View Window on page 84.

**Note:** If the task contains a disk image, the File View window will display a folder named *Devices*. Restoration of a hard drive or its partition has several conditions that need to be observed. For details, refer to Hard Drive Restoration on page 94.
Synchronizing Data

Synchronization is useful if you want two folders to share their content with one another or to fill up their content in a mutual way.

To synchronize your data you have to create a synchronize task. This is done with the help of the **New Task Wizard** which can be opened in three ways:

- On the **File** menu, click **New Task**.
- Click the **New Task** button on the program toolbar.
- Right-click in the Task View window to see the shortcut menu, and then click **New Task**.

Creating synchronization task suggests you to complete six steps:

- **Step 1: Choose Task Type** is described on page 59.
- **Step 2: Select the First Folder** is described on page 60.
- **Step 3: Select the Second Folder** is described on page 60.
- **Step 4: Advanced Synchronizing Settings** is described on page 61.
- **Step 5: Scheduling** is described on page 64.
- **Step 6: Ready to Create New Task** is described on page 64.

**Step 1: Choose Task Type**

In the first step of the **New Task Wizard** you need to select the type of the task you are going to create:

- Select **Synchronize task**, and then click **Next**.
There is no Expert mode for this task, so as you select **Synchronize task**, the checkbox will become unavailable.

**Step 2: Select the First Folder**

In the second step of the *New Task Wizard* you need to specify the first folder to work with. It can be located on any local or external drive seen by Windows Explorer. If you want to work with an FTP/SFTP folder, you have to specify it as the second folder.

- Type a path or click the **Browse for folder** button to browse for the first folder, and then click **Next**.

**Step 3: Select the Second Folder**

In the third step of the *New Task Wizard* you need to define the second folder. It can be located on any local or external drive seen by Windows Explorer, or on a remote FTP/SFTP server.
Synchronizing with a local/external/network/removable drive

- Type a path or click the **Browse for folder** button to browse for the second folder.

Synchronizing with an FTP folder

![FTP Settings](image.png)

To sync with an FTP folder you need to specify **Host**, **Port**, **User**, **Password**, **Location** and **Proxy** settings.

- **Host**: Enter the FTP server name.
- **Port**: Enter the port number. The default value is 21.
- **User**: Enter your FTP user name.
- **Password**: Enter your FTP password.
- **Location**: Type a path of a remote directory to synchronize with, or click the **Select FTP folder** button to select it via the **Select FTP folder** dialog.
The **Select FTP folder** dialog window consists of two parts. The upper part contains the list of folders available on the FTP server, while the other shows the FTP session log messages. After establishing an FTP connection, the list of remote directories will appear. Select the desired directory, and then click **Select**. To create a new directory, click **New folder**.

- Click **Proxy** if your computer is inside a firewall. The **Proxy server settings** dialog will appear.

1. Check **Use FTP proxy** if you want to use FTP proxy. Specify FTP proxy host and, if necessary, authorization data.

2. Check **Use SOCKS server** if you want to use SOCKS server. Select type of the SOCKS server, specify the server name and, if necessary, authorization data.

3. When finished, click **OK**.

Click **Try in passive mode** to initiate the FTP connection, rather than relying on the remote server to set it up. This may be necessary if a firewall does not allow establishing a connection from the outside.

**Synchronizing with an SFTP folder**

Synchronizing with an SFTP folder is very similar to synchronizing with FTP, except that **Port** is 22, and **Proxy** and **Try in passive mode** are unavailable. To synchronize with SFTP you will need to specify **Host**, **Port**, **User**, **Password** and **Location**.

- When finished, click **Next**.

**Step 4: Advanced Synchronizing Settings**

In the fourth step of the **New Task Wizard** you need to define synchronization direction.
Handy Backup can perform three types of folder synchronization:

- **Copy from the first folder to the second**: copies all subfolders and files from the first folder to the second one. If one or several files have identical names and different contents, they will be overwritten.

- **Copy from the second folder to the first**: copies all subfolders and files from the second folder to the first one. If one or several files have identical names and different contents, they will be overwritten.

- **Mirror both folders**: shares folders contents with each other. Each file of either folder will be copied to the other folder. In the dropdown menu you should select how to treat files with equal names.

Check **Delete files which are not in the source** if you want to delete the files in the destination folder that are not present in the source.

If you select to mirror two folders, you need to decide which files have higher priorities. As the dropdown menu appears, select how Handy Backup should manage files with identical names.

- **Copy newer** – replaces older files with newer;
• Copy older – replaces newer files with older;
• Copy smaller – replaces larger files with smaller;
• Copy larger – replaces smaller files with larger;
• Skip – ignores files with the same name.

**Step 5: Scheduling**

This step of the New Task Wizard is described in details in section Step 6: Scheduling for backup tasks on page 43. The only difference being that this time it is synchronization instead of backup.

![New Task Wizard](image)

**Step 6: Ready to Create New Task**

In the last step of the New Task Wizard you need to name your synchronize task.

1. Enter a unique task name in the text field.

![New Task Wizard](image)
2. Check the properties of the newly created task in the box below the name field. If one or more settings are incorrect, click Back to return to previous steps and change the needed parameters. If the task is not intended to be performed right after the creation, you can modify its properties later. To learn about modifying tasks, refer to Modifying Task on page 19.

3. Check Execute this task immediately if you want to run the created task straight away after the completion. If the checkbox is not checked, the task will be executed on schedule specified in Step 5, or can be executed on demand. To learn more, refer to Running task on page 20.

4. Click Finish.

The newly created task will appear in the Task View window.
In this section we introduce what makes up the Handy Backup interface. The Handy Backup main window appears as follows:

### Main Menu

Main Menu consists of six menus, containing commands that provide all functionality of Handy Backup:

- **Main Menu -> File** is described on page 66. The **File** menu is used to manage tasks and change program settings.
- **Main Menu -> View** is described on page 77. The **View** menu is used to change Handy Backup appearance.
- **Main Menu -> Actions** is described on page 79. The **Actions** menu is used to execute tasks.
- **Main Menu -> Service** is described on page 79. The **Service** menu is used to configure program operation as Windows service.
- **Main Menu -> Language** is described on page 80. The **Language** menu is used to select language used in the program.
- **Main Menu -> Help** is described on page 82. The **Help** menu is used to access help, request for support and to register the program.

### Main Menu -> File

The **File** menu is used to manage tasks and change program settings.
The menu is organized as follows:

- **New Task** – Calls for the **New Task Wizard** which starts with selection of task type: Backup, Restore or Synchronize. For more details see *Backing up data* on page 23, *Restoring data* on page 50, or *Synchronizing data* on page 59.

- **Duplicate** – Clones task(s) selected in the Task View window. This command is especially useful if you want to create a task very similar to an existing one without repeating all steps of the **New Task Wizard**. To learn more, refer to *Duplicating Task* on page 20.

- **Execute** – Launches task(s) selected in the Task View window. These tasks will be executed regardless of their schedule and even if they were created for a one-off launch. To learn more, refer to *Running Task* on page 20.

- **Stop** – Interrupts running task(s) selected in the Task View window. In some cases this procedure can take several minutes. To learn more, refer to *Stopping Task* on page 21.

- **Delete** – Deletes selected tasks. To learn more, refer to *Deleting Task* on page 21.

- **Properties** – Allows modifying task properties. This is a way to change virtually everything you defined during the process of task creation: from task name to scheduling options. Here you can also enable e-mail notification and define if you want to launch third-party applications before or after executing the task. To learn more, refer to *Task Properties* on page 67.

- **Settings**: Opens Handy Backup Settings. To learn more, refer to *Settings* on page 70.

- **Configuration**: This submenu is available in Handy Backup version 5.8 or lower. It allows you to export or import tasks, logs and preferences. In versions 6.0 and higher, this option has been removed.

- **Exit**: quits the program.

**Task Properties**

Task Properties dialog is used to view or modify created tasks, and also allows enabling certain features, such as e-mail notification after task completion, or running user-defined applications before or after executing the task. To open the Task Properties window, perform one of the following actions:

- Double-click the desired task in the Task View window.

- Right-click the desired task in the Task View window to see the shortcut menu, and then click **Properties**.

- Select the desired task in the Task View window, and then click the **Task Properties** button on the program toolbar.
• Select the desired task in the Task View window, click the **File** menu, and then click **Properties**.

• Select the desired task in the Task View window, and then press **ALT-ENTER**.

Task properties are divided in six (for unencrypted Restore and Synchronize tasks) or seven (for Backup and encrypted Restore tasks) tabs by categories. **Action** tab contains settings that allow performing certain actions before or after executing the task. Other tabs contain settings assigned during task creation. Task creation is performed with the help of the **New Task Wizard** and is described in details in [Managing data with Handy Backup](#) on page 23.

**Setting Pre- and Post- Actions**

To enable Handy Backup to perform actions before or after executing the task, follow these steps:

1. In **Task Properties**, click the **Actions** tab.
2. Check **Run a program before running the task** if you want Handy Backup to start a third-party application before executing the task. Define the application or batch file to be started. For instance, you may run an anti-viral program to ensure that the files included in the backup set are virus free. Check **Wait for the program before proceeding** to execute the task only after the external application finishes its work.

3. Check **Run a program after running the task** if you want Handy Backup to start a third-party application after executing the task. Define the application or batch file to be started. Check **Wait for the program before finishing** to execute the external application only after the task is completed.

**Enabling Shutdown after Task Execution**

To enable Handy Backup to automatically turn off the computer after execution of the task, follow these steps:

1. In **Task Properties**, click the **Actions** tab.

2. Check **Run a program after running the task**.

3. Type “shutdown.exe --s”.

**Enabling E-mail Notification**

To enable e-mail notification, follow these steps:

1. In **Task Properties**, click the **Actions** tab.
2. Check **Send e-mail notification**.

3. Select **When the operation finishes** if you want to receive notifications after each task, or **When the operation finishes with an error** if you want to be notified of incorrectly finished tasks only.

---

**Note:** To enable e-mail notification you need to specify your e-mail information firstly. This is done in program settings (**File -> Settings**). For details, refer to settings of **E-mail Notification** on page 74.

---

**Settings**

Handy Backup has a number of settings that allow tuning Handy Backup appearance and some of its features. To open the Settings window, perform one of the following actions:

- On the **File** menu, click **Settings**.

- Click the **Settings** button on the program toolbar.

- Press **ALT-F7**.

The window contains the list of customizable settings divided into eight categories:

- **General settings** are described on page 71. **General settings** are used to configure different aspects of program performance.

- **Log settings** are described on page 72. **Log settings** are used to set log size and to tune appearance of the Logs window.

- **File View settings** are described on page 72. **File View settings** allow tuning appearance of the File View window.

- **Transfer settings** are described on page 73. In **Transfer settings** network properties are defined.

- **Prompts** options are described on page 73. In **Prompts** you can define if you want to be prompted when stopping a task execution or deleting a task.
• **E-mail Notification** options are described on page 74. **E-mail Notification** is used to receive reports on performed operations via e-mail.

• **Updates** options are described on page 75. In **Updates** you can adjust updates settings.

• **Plug-ins** options are described on page 76. **Plug-ins** allow you to manage backup presets used in the program.

**General settings**

**General settings** are used to configure different aspects of program performance.

- Check **Launch agent on Windows Startup** if you want Handy Backup agent to be launched on Windows startup. To learn more, refer to **Handy Backup Agent** on page 88.

- Check **Show splash screen on program startup** to see Handy Backup splash screen on program startup.

- Check **Enable Windows Explorer integration** to add Handy Backup commands to the standard Windows context menu.

- Check **Use the Windows TEMP folder** if you want Handy Backup to use the standard Windows temporary folder. In certain cases, e.g. when you enable compression or encryption, Handy Backup requires a temporary directory to store temporary files. TEMP folder must be located on a hard drive that has enough free space, or otherwise Handy Backup operations may fail. If you want to select a different folder, uncheck the box, and then type a path or click the **Browse for folder** button to browse for another TEMP folder.

- Check **Eject the CD/DVD after a backup operation** if you want the program to eject your CD/DVD after backup/restore processes are over.

- Check **Verify the backup after burning** if you want the application to verify if the data burned on the CD/DVD is readable.
• Check **Try online help first** if you want the program to refer to the online help system instead of displaying the program help file. Online help is constantly updated and in some cases can be more complete.

**Log settings**

Log settings are used to set log size and to tune appearance of the Logs window.

![Log Settings Window](image)

• Check **Limit the log size to** if you want to limit the maximum size of Handy Backup logs on your hard drive. Enter the amount of disk space in the field to the right.

To obtain fast knowledge about events, you may prescribe different font colors for different conditions.

• Click the **Color Selection** button near the desired log event to change its appearance in the Logs window.

For more details, refer to **Log Window** on page 85.

**File View settings**

File View settings allow tuning appearance of the File View window.

![File View Settings Window](image)
• Check **Refresh the File View automatically** to make the application refresh this information automatically.

• Check **Only for Local/LAN destinations** to disable this feature for all backup destinations other than local or network drives.

To obtain fast knowledge about changes in files status, you may prescribe different font colors for different conditions.

• Click the **Color Selection** button near the desired file status to change its appearance in the File View window.

For more details, refer to [File View window](#) on page 84.

**Transfer settings**

In the **Transfer Settings** window, network properties are defined.

- **Network operating timeout** – the time the application will wait for the answer of the remote computer before trying to reconnect.

- **Delay before reconnecting** – the time to be awaited between connection attempts.

- **Retries on network errors** – number of connection attempts when experiencing a network error.

- Check **Retry until the operation has succeeded** if you want Handy Backup to resume reconnection attempts until the connection is successful. If checked, the value specified in the previous field is ignored.

**Prompts**

In **Prompts** you can define if you want to be prompted when stopping a task execution or deleting a task.
• Check **Prompt on stopping a task operation** if you want to be asked for confirmation before stopping a task.

• Check **Prompt on deleting a task** if you want to be asked for confirmation before deleting a task.

**E-mail Notification**

**E-mail Notification** is used to receive reports on performed operations via e-mail. This feature allows you to control the progress of all Handy Backup processes even if you cannot access the computer where the program is run.
1. Check **Use e-mail notification** to enable e-mail notifications. Enter the required information into the following fields:

- **SMTP server**: Your incoming mail server address;
- **From**: Contains a name (Handy Backup by default) that will represent a sender of the report;
- **To**: An e-mail address you would like to receive Handy Backup messages to;
- **Subject**: Message subject.
- **Body**: Click **Edit Message Body** to set up the message appearance including welcome, signature etc.

2. Check **Use SMTP authentication** if your SMTP server requires authorization. Enter the required information into the following fields:

- **User**: User name;
- **Password**: User password.

**Updates**

In **Updates** you can adjust updates settings.

1. Click **Check for update...** to make the application connect to the Handy Backup website and check if there are any updates available for download.

Select how often the application should check for updates:

- **Every Day**
- **Every Week**
- **Every 30 days**
- **Never**
Note: Handy Backup requires the Internet connection to check for updates. If it is time for the scheduled check, and computer is not connected to the Internet, it will be skipped.

If there is a new version available for download, Handy Backup will display a notification window with the list of new features, so you can decide if you want to download this version.

**Plug-ins**

The **Plug-ins** tab allows you to manage backup presets used in the program.

- To view the list of plug-ins available for download and installation, click **Add**. Handy Backup will download it from the Handy Backup website and open the **Add Plug-in** dialog. Plug-ins are divided into several categories and displayed as the tree structure. Expand the tree structure to view the full list of plug-ins. To add a new plug-in, select it in the list, and then click **OK**.

- To delete a plug-in, select it in the list, and then click **Delete**.

For details on adding, using and creating plug-ins, please refer to **Plug-Ins** on page 105.
Configuration

Handy Backup allows importing and exporting configuration, including settings, tasks and registration information.

Import

To import Handy Backup configuration, follow these steps:

1. On the **File** menu, point to **Configuration**, and then click **Import**...

![Import Configuration dialog]

2. Type a path or browse for the Handy Backup configuration file.

3. If the configuration file was encrypted during exporting, check **Decrypt** and type the password.

4. Click **Import**. The Configuration Elements dialog will be displayed.

![Configuration Elements dialog]

5. Select configuration elements to be imported, and then click **OK**.

Export

To export Handy Backup configuration, follow these steps:

1. On the **File** menu, point to **Configuration**, and then click **Export**...
2. Select configuration elements to be exported.

3. Enter or browse a path and a name for the configuration file.

4. Check Encrypt to encrypt the configuration file. Type the encryption password and password confirmation in the fields below.

5. Click Export.

Note: Configuration files of Handy Backup version 5.8 and lower are incompatible with Handy Backup 6.0 and higher. To import tasks during an upgrade to 6.0 or higher, simply install the new version above the old one.

Main Menu -> View

The View menu is used to change Handy Backup appearance.

The menu is organized as follows:

- **Toolbar** – Shows/hides Handy Backup Toolbar.
- **Status Bar** – Shows/hides Status Bar in the bottom of the main window.
- **Log Window** consists of three submenus:
  - **Hide/Show Log** – Hides/shows Log View window;
  - **Save Log** – Saves log to a text file;
  - **Clear Log** – Clears the Log View window.
- **Refresh** – Checks current state of selected tasks. If the task is network-based, Handy Backup initiates connection.
**Main Menu -> Actions**

The Actions menu is used to execute tasks.

The menu is organized as follows:

- **Backup** – Runs a selected backup task. It can be applied only to backup tasks.
- **Restore** – Runs a selected restore or backup task. If the task type is "restore" then it will be done according to its properties. If the task type is "backup", then it restores data to the source.
- **Synchronize** – Runs a selected synchronization task.

**Note:** The Actions menu is one of several ways to execute a task. To learn about running tasks, refer to Running Task on page 20.

**Main Menu -> Service**

The Service menu is used to configure program operation as Windows service.

Handy Backup is capable of running as Windows service, which allows executing tasks at specified time, not requiring the user to be logged on.

To enable Handy Backup to run as Windows service, perform the following actions:

1. On the Service menu, click Setup service.

2. Check Setup for different user if you want the application to execute other users’ tasks when running as Windows service. Click Check to check availability of the specified account.

3. Type in the account login information, and then click Setup.

4. When the application finishes configuring Windows service, click OK.

5. In the Service menu, click Work as service.
Note: The service feature is based on the Personal service technology which is aimed to simplify configuring and handling users' accounts and doesn’t violate security in any way.

Main Menu -> Language

The Language menu is used to select language used in the program.

Since version 5.5 Handy Backup features multilingual interface which allows selecting language used in the program. If you are using any version of Handy Backup below 5.5 and would like to update the program, read the instructions in the Order section on the Handy Backup website: http://www.handybackup.net/order.shtml

- To change the language of the interface, click it in the menu.
- Click More Languages... if the language you need is not available in the list. The command will open your default web browser and take you to the web page where you will be able to choose from a complete list of languages on our web site.

To set up your preferred language, follow these steps:

1. Download the respective language file from our web site.

2. Unzip the file and copy it to "Customizes" subfolder in Handy Backup folder ("C:\Program Files\Novosoft\Handy Backup\Customizes\" by default).

The next time you run Handy Backup the language will appear in the Language menu.

You can also create your own language interfaces. For details refer to the next section, How to Create Different Language Versions of Handy Backup.

How to Create Different Language Versions of Handy Backup

The user can participate in translating Handy Backup into new languages. More detailed information is given below:

1. All resources for different languages can be found in xml-files that are located in the Handy Backup installation directory, in the subdirectory Customizes.
2. To create a new language version, it is necessary to copy the file "English.xml" to the same directory, rename and translate it. The name of the file will be displayed in the menu Languages of the application and must indicate the language to which the translation has been made.

3. After a new xml-file has been created or modified, it is necessary to restart Handy Backup for the modifications to take effect (the restart is also necessary after switching to a language).

4. When translating original English resources, keep in mind the following information:

   a. It is necessary to translate only text data, located within the elements "string". For example, in the element <string id="IDS_OP_TYPE_BACKUP">Backup</string> only the word "Backup" is translated.

   b. The document structure, element names and their parameters must stay invariable.

   c. The parameter encoding in the header of the xml-file must indicate the encoding of national symbols, which will be used for storing text data in the xml document, for example:

      ```xml
      <?xml version="1.0" encoding="windows-1251"?>
      ```

      or

      ```xml
      <?xml version="1.0" encoding="iso-8859-1"?>
      ```

      Note: At the moment, Handy Backup does not support Unicode, this is why xml documents with the values "UTF-8", "UTF-16" (or other Unicode encodings) indicated as the encoding parameter may cause the application failure.

   d. According to the XML notation (http://www.w3.org/TR/REC-xml/), the following symbols must be indicated as predefined entities references and character references:

      ```
      Line feed       
      "               &quot;
      ,               &apos;
      &               &amp;
      >               &gt;
      <               &lt;
      \t             &\#9;
      ```

   e. The formatting symbols (%s, %d etc) must stay invariable and in the same order in the lines where they are indicated.

   f. The symbol "&" (&amp;) usually indicates a hot-key (it is underlined when displayed) for accerting control or a menu item by pressing Alt and a corresponding hot-key symbol. At switching to another language, hot-key symbols must get changed this way to stay unique in the active window.

   g. If some lines are missing in any xml-file, or if some lines are not located according to original English resources, the text from original English resources will be displayed.
Main Menu -> Help

The Help menu is used to access help, request for support and to register the program.

The menu is organized as follows:

- **Tip of the Day** – Gives you a random tip about Handy Backup basics.
- **Contents** – Opens contents of Handy Backup help system.
- **Handy Backup on the Web** – Opens your default web browser and takes you to the Handy Backup home page: http://www.handybackup.net.
- **Request for support** – Creates a letter template addressed to the Handy Backup support service. You can write any questions and suggestions about Handy Backup and send it to the support team. Your feedback will be taken into account as soon as possible.
- **Online Backup** – Opens your default web browser and takes you to the information page about Handy Backup Online service: http://onlinebackup.novosoft.net.
- **How to register** – Opens your default web browser and takes you to the Handy Backup price list and price information: http://www.handybackup.net/order.shtml.
- **Enter you serial number** – Opens a window to input a serial number.
- **About Handy Backup** – Provides information about the installed version, copyright holders and the expiration date.

**Toolbar**

Handy Backup Toolbar contains buttons for most vital actions available in Handy Backup:

The Toolbar is organized as follows:

- **New Task**: starts the New Task Wizard. The New Task Wizard works on the step-by-step basis and is used to create all tasks in Handy Backup. See Backing up data on page 23, Restoring data on page 50, or Synchronizing data on page 59 for more details.

- **Execute selected task(s)**: launches tasks selected in the Task View window. The tasks will be executed even if they were created for a single launch or they are out of their schedule at the moment.
Restore selected task(s) or file(s): runs restore/backup tasks selected in the Task View window. Restore tasks are processed according to their properties, and data of the backup tasks is restored to the original location.

Stop selected task(s): interrupts running tasks selected in the Task View window.

Task properties: allows viewing or altering task properties. Use this option if you need to change the settings you defined when creating the task.

Refresh selected task(s): checks availability of selected tasks. It determines if files specified in the task (e.g., for backing up or restoring) can be reached. If the task is network-based, Handy Backup initiates connection and checking.

Delete selected task(s): deletes selected tasks.

Settings: sets up Handy Backup parameters and characteristics.

Register now!: opens a window to input a serial number. See Registration on page 16 for more details.

### Task View Window

The Task View window allows viewing information task profiles. The window contains a full list of tasks ever created in Handy Backup, their progress and current status. Generally six parameters of each task are displayed: Task name, Task type, Last run time, Next run time, Progress and Status.

<table>
<thead>
<tr>
<th>Task name</th>
<th>Task type</th>
<th>Last run time</th>
<th>Next run time</th>
<th>Progress</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Task 1</td>
<td>Restore</td>
<td></td>
<td></td>
<td>9%</td>
<td>Idle</td>
</tr>
<tr>
<td>New Task 2</td>
<td>Restore</td>
<td></td>
<td></td>
<td>9%</td>
<td>Idle</td>
</tr>
<tr>
<td>New Task 3</td>
<td>Synchronize</td>
<td>07.03.2006 15:19...</td>
<td></td>
<td>9%</td>
<td>Success</td>
</tr>
<tr>
<td>New Task 4</td>
<td>Backup</td>
<td>15.03.2006 10:56...</td>
<td>15.03.2006 10:56...</td>
<td>9%</td>
<td>Success</td>
</tr>
<tr>
<td>New Task 5</td>
<td>Backup</td>
<td>15.03.2006 10:56...</td>
<td></td>
<td>9%</td>
<td>Success</td>
</tr>
<tr>
<td>New Task 6</td>
<td>Backup</td>
<td>25.03.2006 17:25...</td>
<td></td>
<td>9%</td>
<td>Success</td>
</tr>
<tr>
<td>New Task 7</td>
<td>Restore</td>
<td>25.03.2006 17:34...</td>
<td></td>
<td>9%</td>
<td>Success</td>
</tr>
</tbody>
</table>

The Task View window allows viewing information task profiles. The window contains a full list of tasks ever created in Handy Backup, their progress and current status. Generally six parameters of each task are displayed: Task name, Task type, Last run time, Next run time, Progress and Status.

- **Task name:** name, given to the task by the user, can be changed in Task Properties.
- **Task type:** type of the task - Backup, Restore, or Synchronization.
- **Last run time:** last time when the task was executed;
- **Next run time:** next scheduled running time;
- **Progress:** the green bar and the percentage indicator show the task progress;
- **Status:** current task status.

There are eight possible statuses for a task:
• **Success**: the operation has been completed successfully;

• **Success**: the scheduled operation has been completed successfully;

• **Error**: the operation has been terminated with an error;

• **Error**: the scheduled operation has been terminated with an error;

• **Scheduled**: the program is waiting to execute a scheduled operation;

• **Idle**: the task is not scheduled and not running;

• **Running**: the program is either performing an operation or refreshing;

• **Stopped**: the operation has been stopped by the user.

Each task has a number of commands that can be performed at any moment. To see the list of available commands, right-click the task to open the shortcut menu:

• **New Task**: does nothing to the task, starts the **New Task Wizard**.

• **Duplicate**: duplicates the task. To learn more, refer to **Duplicating task** on page 20.

• **Backup, Restore or Synchronize**: if corresponds to the task type, does the same as **Execute** command. If the command is **Restore** and the task type is Backup, runs the corresponding **Restore** task.

• **Refresh**: refreshes the information on all files included into the task in the File View window.

• **Execute**: launches the task. The task will be executed even if it was created for a single launch or is out of its schedule at the moment.

• **Stop**: interrupts the task being in process.

• **Delete**: deletes the task.

• **Properties**: opens the Task Properties window, which allows to view or modify task settings.

Since most of these commands are common for all tasks, they can be applied for several tasks at once. To do so, you need to select tasks with the help of usual Windows selection methods (use **CTRL** to select a single task, **SHIFT** to select a row of consecutive tasks, etc.) and right-click on any of the selected tasks to open the shortcut menu. The menu will display the list of common commands that are available for all of the selected tasks.

### File View Window

The File View window is used to manage content processed in your tasks.
The File View window has three general functions:

1. When you select a task in the Task View window, the File View window displays information on all files included into it. This information allows you to track if any data has changed since the last task execution. To navigate through the backup set, use standard Windows methods. Use the menu in the upper part of the window to navigate through the folders hierarchy, or the Go to Parent Folder button to go to an upper-level folder. For a file or folder in the task you can see:
   - **File name**: Path of the file or folder, or name of the backup preset, e.g. <My Documents>;
   - **Status**: Current status of the selected item;
   - **Original size**: Current size of the original file. In certain cases, e.g. if the file was deleted, or if the specified restore location if different than the original, this field will display 0;
   - **Stored size**: Size of the backed up data;
   - **Original time**: Time of last modification of the original file or folder;
   - **Stored time**: Time of last modification of the file or folder stored in backup.

2. The File View window allows you to exclude and include items to the selected backup or restore task. This can be useful if you need a “partial” execution of the task. To do it, select backup items with the help of the standard Windows selection methods (use CTRL to select a single task, SHIFT to select a row of consecutive tasks, etc.), right-click any of the selected items to open the shortcut menu, and then click **Include Files** or **Exclude Files**. Basically, this procedure is equal to adding data to the backup set and unchecking boxes near unneeded items during the process of task creation. For more details, refer to Step 2: What to Backup on page 24.

3. Through the File View window you can back up, restore, or synchronize individual items without performing the entire task. To do it, select backup items with the help of the standard Windows selection methods (use CTRL to select a single task, SHIFT to select a row of consecutive tasks, etc.), right-click any of the selected items to open the shortcut menu, and then click **Backup**, **Restore** or **Synchronize** (depending on the task type).

**Note:** The procedure of restoring separate files and folders through the File View Window doesn’t allow you to perform restoration to locations different than those defined in the task. If you want to change restore location for your data, you need to edit the task first. To learn about modifying tasks, refer to Modifying Task on page 19.

- The fourth option **Settings** shown in the shortcut menu opens the File View settings window. For more details, refer to File View settings on page 72.
The Log window provides you details on task progress. It is being updated during the whole task session, and stores results of all actions and operations. To view log of any of the task, select it in the Task View window and it will be displayed.

As the Log window is not a necessary part of the program’s operation, you can choose whether it will be shown or not.

- On the View menu, point to Log Window, and then click Hide/Show Log.

There is a number of commands regarding Logs that can be performed at any moment.

To save log perform one of the following actions:

- On the View menu, point to Log Window, and then click Save Log…
- Right-click in the Log window to open the shortcut menu, and then click Save Log…

The program will open the Save As dialog to save the log in a text file.

To clear log perform one of the following actions:

- On the View menu, point to Log Window, and then click Clear Log
- Right-click in the Log window to open the shortcut menu, and then click Clear Log

To copy log to the clipboard:

- Right-click in the Log window to open the shortcut menu, and then click Copy

To tune appearance of the Log window:

- Right-click in the Log window to open the shortcut menu, and then click Colors

For more details on adjusting logs settings and Log window appearance, refer to Log Settings on page 72.

**Hot Keys**

Handy Backup supports a number of hot key assignments that can be used in Handy Backup’s interface. Hot keys are not case-sensitive and can be used at any time when the program allows the command execution.

**Task management hotkeys:**

- **Ctrl+N** – Starts the New Task Wizard to create a new task;
- **Ctrl+F5** – Executes task or tasks selected in the Task View window;
- **ESC** – Interrupts task or tasks selected in the Task View window;
- **DEL** – Deletes task or tasks selected in the Task View window;
- **F5** – Refreshes task selected in the Task View window. Can be applied to a single task only;
• **Alt+ENTER** – Opens task properties to view or modify the task selected in the Task View window.

**General hotkeys:**

• **Alt+F7** – Opens the program settings.

• **F1** – Opens the program help file.

• **Alt+F4** – Closes Handy Backup without stopping the Handy Backup Agent.
Handy Backup Agent

When you start Handy Backup, Handy Backup agent icon appears in the system tray. It doesn't require much system resources and has the following functions:

- Indicates that Handy Backup is running;
- Enables the program scheduler to work;
- Allows opening the program window by double-clicking the agent icon;
- Allows using the agent menu. To learn more, refer to the next section Agent Menu.

Working status

When the Handy Backup window is inactive, the agent indicates the working status of the application:

- - One or several tasks are running at the moment;
- - One or several operations have finished with an error.

Agent Menu

To open the Agent menu, right-click the agent icon in the system tray. The list of available commands will appear.

- **Open Handy Backup:** opens the program window if it's closed or minimized.
- **Execute all tasks:** executes all tasks simultaneously.

**Note:** This command can’t be used if you have more than one task working with CD/DVD drive. Only one task that will be first to lock the CD drive will be executed.

- **Execute:** allows executing any specific task or running FTP Rebind.

**FTP Rebind** synchronizes local information about the backup set with files existing on an FTP server. This allows you to reduce execution time of a new task by performing incremental backup instead of full one.

Usage of the **FTP Rebind** function is done in the following way:

1. Manually copy data you want to back up from your computer to an FTP server.
2. Create a backup task for the data on the FTP server. Do not launch this task.
3. Use FTP Rebind to create `backup.hbi` file without actually performing time-consuming backup operation.

After applying the FTP Rebind function you will be able to perform incremental backup and back up only new and updated files of your computer.

- **Exit**: exits the application (the program will be terminated and the agent will disappear from the system tray).

## Command Line

Handy Backup can perform a number of operations with the use of the command line, which allows you to manage tasks without opening the program window. This is done with the help of the Handy Backup Agent. To open the window describing the command line syntax, follow these steps:

1. On the **Start** menu, click **Run**.
2. Type a path or browse for the Handy Backup Agent execution file (`backup.exe`).
3. Add the “-help” or “-?” key and then click **OK**.

The window with Handy Backup command line syntax will open.

Working with Handy Backup through the command line, you can use either a full key or its contracted form (for instance, "-Execute" or "-e").

**Note:** The **Execute All** command cannot be used if you have more than one task working with CD/DVD drive. Only one task that will be first to lock the CD drive will be executed.

Managing tasks by using the command line can noticeably fasten all of your backup processes. For instance, you may create a shortcut allowing you to back up your entire hard drive. To do so, just create the corresponding task, then create a shortcut launching that task (`backup.exe -e <task>`) and place it on the desktop. Next time you will need to back up your hard drive, simply double-click the shortcut.
Handy Backup comes in multiple editions which differ in features and data presets available for backup. Comparison chart of functionalities of different Handy Backup editions is always available on the program website at the following URL: http://www.handybackup.net/backup-comparisons.shtml

Backup presets are items shown in the selection menu during the process of backup task creation. The basic principle is that the user only specifies the item he wants to include to backup and Handy Backup automatically locates the needed files and adds them to the backup set. Below is a list of “common” items that can be backed up in any edition:

- Files, folders and FTP files
- Windows registry
- Desktop
- My Documents
- Favorites
- Microsoft Outlook files
- Outlook Express files
- ICQ files
- Email Messages backup is described on page 103.

Apart from the items listed above, Handy Backup can back up different frequently used applications such as design tools, instant messengers, mail clients, etc. This is done through the use of backup plug-ins which exploit files-based backup method. To learn more, refer to Plug-Ins on page 105.

In Handy Backup, the term “upgrade” doesn’t imply installation of new or modification of the original software, which is called “update” (to learn more, refer to Updates on page 91). Each Handy Backup license is prescribed to a specific computer, and the functionality of each program copy is strongly bound with its registration serial number. When you purchase an upgrade, you don’t get any software packs to update the program: what you receive is an update of your registration key in our customer database (e.g. the information about the features your serial number allows using in Handy Backup).

The following features and backup plug-ins require the presence of the appropriate upgrades, e.g. they can be used only if they are prescribed to your registration number in our database:

- Support for DVD, Blu-Ray and HD DVD as storage media;
- Support for SFTP server as storage location;
- **Disk Image** plug-in is described on page 92. This plug-in is used to create drive image backup with all applications and system records.
- **Database backup** plug-in is described on page 94. This plug-in allows backing up databases that support the Open Database Connectivity (ODBC) driver.
- **Lotus Notes backup** plug-in is described on page 100. This plug-in provides a fast and reliable way to back up the popular IBM communication and collaboration application.
• **MS Exchange backup** plug-in is described on page 102. This plug-in allows backing up the popular Microsoft messaging and collaboration service.

• MSSQL backup. Unlike database backup plug-in which uses the ODBC protocol, this plug-in exploits the Microsoft API technology and allows backing up the popular Microsoft database management system.

**Note:** During the 30-days trial period of the program, all these features are available. If you want use some features not available within the Handy Backup Standard functionality you need to purchase them as an additional upgrade. The latest information about upgrades is always available in the **Order** section on the product website: [http://www.handybackup.net/order-upgrades.shtml](http://www.handybackup.net/order-upgrades.shtml).

**Note:** Some of the above listed features may be unavailable in early versions of Handy Backup. To learn about updating Handy Backup, refer to the next section **Updates**.

---

### Updates

Handy Backup is constantly developing to keep in step with the evolving computer technologies. The latest version of the program is always available for download at the product website [http://www.handybackup.net](http://www.handybackup.net). To check for newer versions of Handy Backup, go to **Settings**, click **Updates**, and then click **Check for update...** Setting automatic checking is done in the same window. For more details, refer to **Settings -> Updates** on page 75.

In some cases Handy Backup may require to repeat registration procedure after the update. Usually this happens if the newer version has gained new functionalities or undergone some major changes and the update needs to be purchased. The price (or its absence) of updates is set in accordance with the following policy:

- Any changes that are not related to the feature set you use come free of charge. All you need to do is download the new version and install it instead of the old one. For details, refer to **Updating from Earlier Versions** on page 14.

- If the new version contains only bug fixes, or minor changes (“secondary” features) it also comes free of charge.

- Major changes that affect all editions of the program usually require the user to pay for updating the registration key to the latest version.

**Note:** If you are satisfied with the functionality of the version you have, you may choose to not update it. Moreover, you can always download the latest version that doesn’t require you to pay for updating your registration number in the Download section on the product website: [http://www.handybackup.net/download.shtml](http://www.handybackup.net/download.shtml).

**Note:** All users of Handy Backup are entitled to free technical support, independently from the version of program they use.

The latest information about upgrades is always available at [http://www.handybackup.net/order-upgrades.shtml](http://www.handybackup.net/order-upgrades.shtml).
Image Backup

Handy Backup allows you to create an exact copy of your entire hard drive or its partitions by duplicating their physical contents sector by sector. Image backup is a low-level disk copying which gives no regard to separate files, and therefore no data can be missed. The resulting image contains not only common files and folders, but also system and hidden files, compressed and encrypted files and even boot records. This enables you to restore your system to the working state after fatal system errors or hard drive crashes.

To perform backup of your hard drive or its partitions, follow these steps:

1. Launch the **New Task Wizard**.
2. Select **Backup Task**, and then click **Next**.
3. Click **Add** to open the shortcut menu. The list of available for backup items will appear.
4. Select **Disk Image**. The list of available for image backup devices will appear.

The devices are presented in the tree form and include all FAT16, FAT32 and NTFS compatible hard drives and partitions, including external USB and FireWire drives.
5. Check each device you want to back up, and then click **Next**.

**Note:** If you want to back up one or several partitions, you need to back up the partition table as well – it is required for configuring the partitioning when you restore your drive backup. When you check the entire hard drive, its partition table is included into the backup set automatically.

6. Select **Full Backup**, and then click **Next**.

The subsequent steps are identical to usual backup task creation. For more details, refer to Backing up data on page 23.

**Before You Back Up**

To perform an image-based backup, you need to observe two conditions:

1. The hard drive or partition that is going to be backed up has to remain unchanged during the backup process and shouldn’t have any applications (including Handy Backup) running on it.

We recommend closing all running applications to make sure that they won’t affect the partition that is being backed up.

2. The location of Handy Backup Temporary Folder cannot be set to the hard drive or partition that is going to be backed up.

To change the current Temporary Folder, follow these steps:

1. On the **File** menu, click **Settings**, or click the **Settings** button on the program toolbar.

2. Click **General Settings**.

3. Check **Use the Windows TEMP folder** if you want to use the default Windows temporary folder, or specify your own temporary folder. Remember, that it mustn’t be located on the partition that you are going to back up.
Where to Back Up

Backup image can be stored on any kind of storage media supported by Handy Backup, such as local or network hard drives, CD/DVD, FTP/SFTP, etc. However, you need to make sure that the partitions you are going to back up are not assigned as backup destinations, and will remain unchanged during the backup process.

Note: Since image backup usually requires a lot of free disk space, make sure that the storage media is large enough.

When backing up to CD/DVD, Handy Backup allows you to divide the image into several parts to fit the capacity of discs. If you burn your image backup to several removable media, be sure to number them, since you will have to insert them in order during the restoration.

Hard Drive Restoration

After you have created a backup copy of your hard drive (or a partition of your hard drive) you can restore all information including data files and system settings. For successful restore of a hard drive or drive partition the following two conditions must be observed:

1. Make sure that the partition that you are going to restore exists on your Hard Drive. For example, if you restore disk D of your hard drive, you need to make sure that disk D is available on your computer.

2. After you have restored the hard drive, at first you won't see any changes. To make the new settings take effect, perform one of the following actions:
   - Run disk check on the restored drive;
   - Disconnect and connect the device again (if you're working with an external drive or flash drive);
   - Reboot the computer.

Note: To make Handy Backup perform disk check automatically, you can create a batch file with the above command and enable its execution after completing the task. For more details, refer to Setting Pre- and Post-Actions on page 68.

Database Backup

Handy Backup features ability to backup databases that support Open Database Connectivity (ODBC) driver. The most popular ODBC compatible databases are Oracle, MySQL and MS SQL.

To back up these databases, follow these steps:

1. Launch the New Task Wizard.

2. Select Backup Task, and then click Next.

3. Click Add to open the shortcut menu. The list of available for backup items will appear.
4. Select **Database**. Data Source Selection window will appear.

5. Select **File Data Source** or **Machine Data Source** by clicking the respective tabs.

File Data Source is stored as a regular file on your local computer. Machine Data Source is stored as the system source in the System Registry.

6a. On the **File Data Source** tab, click the **Size** arrow to select file data sources created earlier on your computer or remote computer. If there are no data sources for your database, create a new one. To learn more, refer to **File Data Source** on page 96.

6b. On the **Machine Data Source** tab, select the desired data source from the list or create a new machine data source. To learn more, refer to **Machine Data Source** on page 98.
7. Select the desired data source, and then click **OK**. The data from the database will be added to the backup set.

8. If you want to exclude one or several database tables from the list, expand the tree panel and uncheck the respective boxes.

9. When finished, click **Next**.

The subsequent steps are identical to usual backup task creation. For more details, refer to [Backing up data](#) on page 23.

**Note:** Handy Backup can only back up database tables. It cannot back up store procedures, views, functions, triggers etc from the database.

**File Data Source**

The **File Data Source** tab is used to open data from a file source with the help of ODBC driver. You can specify file data source located on both local and remote computers.

If you already have a file data source, you may use it to do the backup of the selected database.
To create a new file data source, follow these steps:

1. Click **New**… to create a new file data source. A standard ODBC dialog will appear.

2. Select a driver for which you want to create a data source.

3. Click **Advanced** if you know the driver-specific keywords for this data source. When the Advanced File DSN Creation Settings dialog appears, type the driver-specific keywords. Check **Verify this connection** to ensure that the driver can make connection to the data source (will be performed when you finish entering the keywords). Click **OK**.

4. When you have chosen the driver and specified advanced settings, click **Next**.

5. Type the name of the file data source, and then click **Next**.

6. Check the properties of the newly created data source. If one or more settings are incorrect, click **Back** to return to previous steps and change the needed parameters. Click **Finish** to finalize the data source creation.
The described procedure creates a file data source that is stored in your local computer as a single file. The file you created will appear in the Data Source Selection window. It can be used to create database backup tasks, and can be accessed from both local and remote computers.

**Note:** In some cases the driver may not find the database automatically and you will have to specify additional settings such as path to the data to be backed up.

**Machine Data Source**

The machine data source is located in your system registry. It is specific for your machine and cannot be shared with other computers on the network. If you want, it can be used only by other users of the same computer.
To create a new data source, follow these steps:

1. Click **New...**

2. Select **User Data Source** to make the new data source available to the current user only, or **System Data Source** to allow all users of the computer use it as well. Click **Next**.

3. Select a driver for which you want to create a data source, and then click **Next**.
4. Check the properties of the newly created data source. If one or more settings are incorrect, click Back to return to previous steps and change the needed parameters. Click Finish to finalize the data source creation.

5. The newly created data source will appear in the Data Source Selection window.

Note: In some cases the driver may not find the database automatically and you will have to specify additional settings such as path to the data to be backed up.

Lotus Notes Backup

Handy Backup features ability to back up databases of Lotus Notes version 6.5 and higher. You can perform either full backup of all Lotus Notes files or selective backup of specific file categories such as contacts, logs, journal entries, emails, etc.

To be able to add Lotus Notes to the backup set, you need to write the root directory (the directory where nlsxbe.dll is located) of Lotus Notes in the Path Environment variable. To do it, follow these steps:

1. Right-click My Computer to open the shortcut menu, and then click Properties.

2. On the Advanced tab, click Environment Variables.
3. In the **System Variables** box, select **Path**, and then click **Edit**.

4. In the **Edit System Variable** dialog, add Lotus Notes directory path in the end of the **Variable Value** field (type a semicolon and then the path without spaces), and then click **OK**.

**Note:** The procedure described above is applicable to Windows XP, if you are using a different operating system you may find slight differences in the System Properties interface.

After you have added Lotus Notes Directory to System Path variable, you can perform Lotus Notes backup. To add Lotus Notes data to the backup set, follow these steps:

1. Launch the **New Task Wizard**.

2. Select **Backup Task**, and then click **Next**.

3. Click **Add** to open the shortcut menu. The list of available for backup items will appear.

4. Select **Lotus Notes**.
5. Expand the tree panel to see the list of Lotus Notes file categories available for backup. To exclude one or several items from the backup set, uncheck the respective boxes. When finished, click **Next**.

The subsequent steps are identical to usual backup task creation. For more details, refer to Backing up data on page 23.

---

**MS Exchange Backup and Restore**

Before you back up MS Exchange servers, make sure that your system configuration observes two conditions:

1. The firewall must allow Handy Backup to access local area network and connect to the MS Exchange servers.
2. Handy Backup must be run under a user account that has Microsoft Windows server operating systems Backup and Restore privileges.

To perform backup of MS Exchange Server, follow these steps:

1. Launch the **New Task Wizard**.
2. Select **Backup Task**, and then click **Next**.
3. Click **Add** to open the shortcut menu. The list of available for backup items will appear.

4. Select **MS Exchange**.

5. Expand the tree panel to see the list of MS Exchange servers that are currently available for backup. To exclude one or several folders from the backup set, uncheck the respective boxes.
6. When finished, click **Next**.

The subsequent steps are identical to usual backup task creation. For more details, refer to **Backing up data** on page 23.

**MS Exchange database restore**

The restore procedure of MS Exchange requires some preparations to be done before executing the restore task. To ensure successful restoration of your MS Exchange Please backup, follow these steps:

1. Click the **Start** button, and then point to **All Programs**. Point to **Microsoft Exchange**, and then click **System Manager**.

2. If the **Administrative Groups** branch is in the left pane, expand it, and then expand the appropriate administrative group branch, also expand the **Servers** branch, and then expand the appropriate server branch. If the **Administrative Groups** branch is not there, expand the **Servers** branch in the left pane, and then expand the appropriate server branch. To expand a branch, double-click the branch or click the "plus" to the left of the branch.

3. For each database that you want to restore, expand the associated storage group branch, right-click the database, and then click **Dismount Store**. In addition, right-click each database, select **Properties**, select the **Database** tab, make sure that the **This database can be overwritten by a restore** box is checked, and then click **OK**.

After you have completed the preparatory tasks, you can launch the restore operation.

---

**E-mail Box Backup**

Handy Backup features ability to back up mailbox directly from the mail server. This is especially useful for those people who don't have a mail client and use online mail service via web browser. To skip stages of downloading web service's website and entering the mail account, you can use the mail backup feature of Handy Backup and easily retrieve your mail from the remote mail server.

To back up your mail directly from the remote mail server, follow these steps:

1. Launch the **New Task Wizard**.
2. Select **Backup Task**, and then click **Next**.

3. Click **Add** to open the shortcut menu. The list of available for backup items will appear.

4. Select **Email Messages**. The Connection Parameters dialog will appear.

5. In the Connection Parameters dialog, enter your POP3 Mail Server address, user name, account password and a path to restore.

   Since POP3 protocol doesn’t allow restoring mail messages back to the server, Handy Backup requires the restore path for your messages.

6. To ensure that the settings you provided for the mail server are correct, click **Check settings**. To add your mail to the backup set, click **OK**.

   The subsequent steps are identical to usual backup task creation. For more details, refer to **Backing up data** on page 23.

   **Note:** POP3 protocol allows backing up only incoming messages of your mailbox. If you want to back up other messages stored in your mailbox, you need to transfer them to the Incoming folder and then back them up as if they were incoming.

   **Note:** Make sure your mail server supports POP3. Most mail servers do, but if you are not quite sure, you can find this information on the server's web site.
Plug-Ins

There is a number of plug-ins that make the use of Handy Backup easier. Basically plug-ins are explicit presets that allow backing up data and settings of different popular applications, such as mail clients, web browsers, design tools, instant messengers, etc. Plug-ins exploit files-based backup method and can be easily downloaded from Handy Backup website free of charge. To learn more, refer to the following sections:

- **Why Use Plug-Ins** is the next section.
- **Installing and Uninstalling Plug-Ins** is described on page 106.
- **Using Plug-Ins** is described on page 107.
- **Creation of Plug-Ins** is described on page 108.

**Why Use Plug-Ins**

Plug-ins can be useful when you specify data set during the process of backup task creation. The basic principle is that you only need to select an item you want to include to backup and Handy Backup will automatically locate all needed files and add them to the backup set. For more details on using backup presets, refer to **Using Plug-Ins** on page 107.

The list of installed plug-ins can be seen you have when you click Add in **Step 2: What to Backup** (described on page 24). Another way to see the list of available plug-ins and plug-in categories is in the program settings:

1. On the **File** menu, click **Settings**, or click the **Settings** button on the program toolbar.
2. Click **Plug-ins**. The list of currently installed plug-ins will appear.
3. Expand the categories to see the list of plug-ins.

The procedure of adding and removing plug-ins is described in the next section, Installing and Uninstalling Plug-Ins.

**Installing and Uninstalling Plug-Ins**

To add or remove plug-ins, follow these steps:

1. On the File menu, click Settings, or click the Settings button on the program toolbar.
2. Click Plug-ins. The list of currently installed plug-ins will appear.

3. To view the list of plug-ins available for download and installation, click Add. Handy Backup will download it from the Handy Backup website and open the Add Plug-in dialog. Plug-ins are divided into several categories and displayed as the tree structure. Expand the tree structure to view the full list of plug-ins. To add a new plug-in, select it in the list, and then click OK.
4. To delete a plug-in, select it in the list, and then click **Delete**.

5. When finished, click **OK**.

**Note:** To add plug-ins, your computer must be connected to the Internet:

Plug-ins can also be downloaded and installed during the process of backup task creation. To learn more, refer to Using plug-ins on page 107.

To see the latest list of plug-ins available for download and installation, visit the Handy Backup website [http://www.handybackup.net/backup-plugins.shtml](http://www.handybackup.net/backup-plugins.shtml)

### Using Plug-Ins

To use plug-ins in backup task creation, follow these steps:

1. Launch the **New Task Wizard**.

2. Select **Backup Task**, and then click **Next**.

3. Click **Add** to open the shortcut menu. The list of available for backup items, including all installed plug-ins, will appear.

4. To add new plug-ins, select **More**... Handy Backup will download the list of available for installation plug-ins from the Handy Backup website and display it in a new window. Select the desired plug-in, and then click **OK**.
The subsequent steps are identical to usual backup task creation. For more details, refer to Backing up data on page 23.

**Creation of Plug-Ins**

If you need a plug-in, but it's neither in the application nor on the Web, you can create a plug-in by yourself or send us a request to create a custom plug-in for you. See the instructions for plug-in creation in the following sections.

**Search Algorithms**

3 algorithms of the path search on the given parameters in the element "Path" are realized. The type of an algorithm is given by the element "Type". The possible values 1,2,3:

There is a key search in the path of the Registry "HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\App Paths\<KeyPath>".
If the key is found, we look for the variable <KeyValue> in this key. If there is the variable, we read it. There must be the path to the folder where the program is located. We look for the file <FileName> on this path. If this file exists, it means this is the needed path. Hence, the search is unzipped.

There is a search of the key, containing the information about the file extension associated with the program, in the path of the Registry "HKEY_CLASSES_ROOT\<KeyPath>".
If the key is found, we look for the variable <KeyValue> in this key. If there is the variable, we read it. There must be the path to the folder, where it is the program, in the following format: <the path to the folder>, <identifier>. We look for file <FileName> on this path. If this file exists, it means that this is the needed path. Hence, the search is unzipped.

There is a key search in the path of the Registry "<KeyPath>".
If the key is found, we look for the variable <KeyValue> in this key. If there is the variable, we read it. There must be the path to the folder, where it is the program. We look for the file <FileName> on this path. If this file exists, it means this is the needed path. Hence, the search is unzipped. If the value<IncludeSub>=TRUE, then, if the search fails, there is the search of values of all keys included in <KeyPath>.

**Windows Environmental Variables**

$PATH$ - Path to the folder, where the program is installed. It is determined in the element <Path>.
Variables for the description of path to system folders Windows:

$ADMINTOOLSS$ - File system directory that is used to store administrative tools for an individual user
$ALTSTARTUP$ - File system directory that corresponds to the user's nonlocalized Startup program group.

$APPDATA$ - File system directory that serves as a common repository for application-specific data. A typical path is C:\Documents and Settings\username\Application Data

$CDBURN_AREA$ - File system folder used to hold data for burning to a CD. Typically [User Profile Folder]\Local Settings\Applications Data\Microsoft\CD Burning.

$COMMON_ADMINTOOLS$ - File system directory containing administrative tools for all users of the computer.

$COMMON_ALTSTARTUP$ - File system directory that corresponds to the nonlocalized Startup program group for all users. Valid only for Windows NT® systems.

$COMMON_APPDATA$ - Application data for all users. A typical path is C:\Documents and Settings\All Users\Application Data.

$COMMON_DESKTOPDIRECTORY$ - File system directory that contains files and folders that appear on the desktop for all users. A typical path is C:\Documents and Settings\All Users\Desktop. Valid only for Windows NT® systems.

$COMMON_DOCUMENTS$ - File system directory that contains documents that are common to all users. Typical paths are C:\Documents and Settings\All Users\Documents.

$COMMON_FAVORITES$ - File system directory that serves as a common repository for all users' favorite items. Valid only for Windows NT® systems.

$COMMON_MUSIC$ - My Music folder for all users.

$COMMON_PICTURES$ - My Pictures folder for all users.

$COMMON_PROGRAMS$ - File system directory that contains the directories for the common program groups that appear in the Start Menu for all users. A typical path is C:\Documents and Settings\All Users\Start Menu\Programs. Valid only for Windows NT systems.

$COMMON_STARTDIRECTORY$ - File system directory that contains the programs and folders that appear on the Start Menu for all users. A typical path is C:\Documents and Settings\All Users\Start Menu. Valid only for Windows NT systems.

$COMMON_STARTUP$ - File system directory that contains the programs that appear in the Startup folder for all users. A typical path is C:\Documents and Settings\All Users\Start Menu\Programs\Startup. Valid only for Windows NT systems.

$COMMON_TEMPLATES$ - File system directory that contains the templates that are available to all users. A typical path is C:\Documents and Settings\All Users\Templates. Valid only for Windows NT systems.

$COMMON_VIDEO$ - My Video folder for all users.

$CONTROLS$ - Virtual folder that contains icons for Control Panel applications.

$COOKIES$ - File system directory that serves as a common repository for Internet cookies. A typical path is C:\Documents and Settings\username\Cookies.

$DESKTOP$ - Windows desktop-virtual folder that is the root of the name space.

$FAVORITES$ - File system directory that serves as a common repository for the user's favorite items. A typical path is C:\Documents and Settings\username\Favorites.

$FONTS$ - Virtual folder that contains fonts. A typical path is C:\WINNT\Fonts.
$\text{HISTORY}$ - File system directory that serves as a common repository for Internet history items.

$\text{INTERNET\_CACHES}$ - File system directory that serves as a common repository for temporary Internet files. A typical path is C:\Documents and Settings\username\Temporary Internet Files.

$\text{LOCAL\_APPDATA}$ - File system directory that serves as a data repository for local (nonroaming) applications. A typical path is C:\Documents and Settings\username\Local Settings\Application Data.

$\text{MYMUSIC}$ - File system directory that serves as a common repository for music files. A typical path is C:\My Music.

$\text{MYPICTURES}$ - My Pictures folder. A typical path is C:\Documents and Settings\username\My Documents\My Pictures.

$\text{MYVIDEOS}$ - File system directory that serves as a common repository for video files.

$\text{NETHOOD}$ - A file system folder that contains the link objects that can exist in the My Network Places virtual folder. A typical path is C:\Documents and Settings\username\NetHood.

$\text{PERSONALS}$ - File system directory that serves as a common repository for documents. A typical path is C:\Documents and Settings\username\My Documents. This is different from the My Documents virtual folder in the name space.

$\text{PRINTHOOD}$ - File system directory that contains the link objects that can exist in the Printers virtual folder. A typical path is C:\Documents and Settings\username\PrintHood.

$\text{PROFILE}$ - User's profile folder.

$\text{PROGRAM\_FILES}$ - Program Files folder. A typical path is C:\Program Files.

$\text{PROGRAM\_FILES\_COMMON}$ - A folder for components that are shared across applications. A typical path is C:\Program Files\Common. Valid only for Windows NT and Windows 2000 systems.

$\text{PROGRAMS}$ - File system directory that contains the user's program groups (which are also file system directories). A typical path is C:\Documents and Settings\username\Start Menu\Programs.

$\text{RECENT}$ - File system directory that contains the user's most recently used documents. A typical path is C:\Documents and Settings\username\Recent.

$\text{SENDTO}$ - File system directory that contains Send To menu items. A typical path is C:\Documents and Settings\username\SendTo.

$\text{STARTMENU}$ - File system directory that contains Start Menu items. A typical path is C:\Documents and Settings\username\Start Menu.

$\text{STARTUPS}$ - File system directory that corresponds to the user's Startup program group. The system starts these programs whenever any user logs onto Microsoft® Windows NT® or starts Microsoft® Windows® 98. A typical path is C:\Documents and Settings\username\Start Menu\Programs\Startup.

$\text{SYSTEM}$ - System folder. A typical path is C:\WINNT\SYSTEM32

$\text{TEMPLATESS}$ - File system directory that serves as a common repository for document templates.

$\text{WINDOWS}$ - Windows directory or SYSROOT. This corresponds to the \%windir\% or \%SYSTEMROOT\% environment variables. A typical path is C:\WINNT.